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CHAPTER 1 – Introduction 
 
CORK’s vision is to be recognized as the preferred provider of regattas in the largest freshwater 
sailing facility in the world.  The timely and accurate collection, processing and communication of 
racing results to competitors, coaches, jury and other regatta participants are critical success 
factors for realizing this vision.    

1.1 About CORK 
 

Since 2000 alone, CORK has hosted dozens of North American and World Championships out 
Portsmouth Olympic Harbour in Kingston, Ontario.  Each regatta differs depending on the class of 
sailboats, the number and level of competitors and several other factors.  While event details 
change from year to year, CORK hosts a minimum of four core multi-course regattas in August and 
September each year: 
 

• International Optimist Regatta – about 150 competitors 8-15 years old in two-three fleets.  
Qualifying and Final series for World Sailing-ranked competitors.  

• International – up to 500 competitors and coaches in three classes (Laser Radial, Club 420, 
29er) and ‘Under 19 (U19)’ and ‘Under 23 (U23)’ age groups.  Qualifying and Final series 
for some classes.   

• Olympic Classes Regatta (OCR) – about 150 competitors in six classes (Laser Standard, Laser 
Radial, Finn, 49er, 49erFX, I14, RS:X).  

• Fall Regatta with Ontario Combine – about 175 competitors in six classes (Laser Radial, 
Laser Standard, Club 420, Optimist, 29er, 49erFX). 

1.2 About CORK’s Results Management Manual 
 
CORK’s Results Management Manual was initiated in 2016 to be a platform for consistent and 
effective scoring of CORK events.  This Manual provides step-by-step details of scoring 
requirements and functions before, during and at the end of a typical CORK multi-class regatta.  It 
was developed collaboratively by pooling the knowledge and experience of sailing officials who 
have experience organizing and running multi-class regattas throughout Canada and 
internationally. 
 
The Results Manual is the basis of continuous improvement in CORK’s Scoring System which 

integrates competitors’ registration data from the CORK Registration Management System (CRMS) 
and Sailwave – a fully featured, easy-to-use, multi-lingual, sailing results/scoring application for 
Windows developed in 2002. 
 
While the Results Manual is designed for use at CORK, its content - step-by-step processes and 
tools - serve as a curriculum for training and recruiting volunteers who want to join the CORK 
Results Team – a cadre of qualified scorers who contribute to the success of each regatta.  Scoring 
skills learned at CORK are transferable to sailing clubs everywhere.  

http://www.sailwave.com/
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CHAPTER 2 – CORK Scoring System 

2.1 Definitions: Scoring, Scorer, Results 
 
In simple terms, scoring is the process comprised of several procedures or actions, scorer is the 
person performing the scoring procedures and results are the product or output of scoring a 
sailing event.  The timely communication of accurate results is the main objective of the Results 
Team.  
 
A typical multi-course sailing event at CORK consists of two-three circles of competition or 
courses.  Each course may have one or more classes of boats depending on the number of 
competitors who register to compete in the event.  A group of competitors (i.e. a class of boats 
competing in the event) is called a fleet.1  A regatta is a sporting event consisting of a series of boat 
or yacht races.  For purposes of this Manual, the terms ‘event’ and ’regatta’ are inter-changeable.  
See the Glossary in Appendix A for other definitions that you may see in this Manual.  
 
CORK organizes races consistent with the Racing Rules of Sailing (RRS) which govern the sport of 
sailing on the water.  Two important RRS sections relating to scoring can be found in Appendix B 
of this Manual. 

2.2 Scoring System Overview 

 
Teamwork 
 

As described in the RRS, several different groups of officials must work together to organize and 
successfully conduct a series of races.  Part 7 of the RRS outlines the rules for organizing races by 
an ‘organizing authority’ such as CORK, which appoints a ‘race committee’ and a ‘protest 
committee’ or jury.  According to RRS 90.3, the Race Committee is responsible for results – i.e. the 
product created from scoring a series of races.  
 
Before and during a CORK event, members of the Results Team must work with two groups of 
volunteers – Event Services (i.e. the organizing authority) and Race Committee.  The Chief Scorer 
typically recruits members of the Results Team, and may assign them to specific events.  However, 
scorers may volunteer for specific events on the CORK website, or be recruited by a Race Officer 
who conducts the races.  
 
In addition to the Race Committee, the Results Team works collaboratively with four other teams 
before, during and after each day’s racing and at the end of the regatta.  A good understanding of 
the responsibilities of each team fosters teamwork which validates the race information and 
results for each course.   

 
1 Large fleets of competitors may be split into groups:  In a Qualifying series, groups of boats compete in ‘flights’; in the 
Final series of races, competitors are assigned to ‘fleets’ - see Chapter 5 for details. 

http://www.sailing.org/documents/racingrules/
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Flowchart of Scoring System 
 

The CORK Results Management Manual is organized to make is easy for a first-time scorer to 
follow the work required in each of the three phases of the scoring experience – preparing for 
scoring (chapters 3 and 4), scoring (chapters 6 and 7), confirming final results (chapter 8).    
 
Below is a description of the phases and the primary tasks involved in CORK’s Scoring System: 
 

 
 
 
 

Chapter 3 – Event/IT Support:  Set-up Regatta   
Before the regatta begins, the Lead Scorer reviews the Notice of Race (NoR) and Sailing 
Instructions (SI’s), schedules scorers to each event and works with Event/IT Support to set-up the 
Sailwave files on CORK computers in the Results Room.    
 
Chapter 4 –Registration: Import Competitors   

Results Team Flowchart v5 (Dec. 2018) 
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After the Sailwave files are configured, the Lead Scorer will import competitor data from CRMS 
and prepares lists of competitors for use by the Race Committee on-water. 
 
Chapter 5 – Managing Split Fleets: Qualifying and Final Series 
Each day of a qualifying series of races, Senior Scorers set-up flight assignments, enter and score 
finish data as one group.  At the end of the qualifying series, the Senior Scorer assigns fleet 
assignments and scores each day’s results by fleet.   
 
Chapter 6 – Race Committee: Score Races   
Each day, the Race Committee runs races on-water and transmits finish positions for each race to 
the Results Team.  On-shore in the Results Room, the Scorer assigned to that course:  

• inputs each competitor’s finish position for the race into a Sailwave file;  
• scores the race by tapping ‘rescore’ - a Sailwave button which calculates the number of total 

points for each competitor2; and 
• publishes results to the website and posts on the official notice board. 

 
Chapter 7 – Enter Scoring Changes:  Jury / Protest Committee 
Each day, the Scorer may need to enter penalties and other scoring changes related to scoring 
inquiries, racing rule infractions or decisions received from the Jury related to protest or redress 
hearings.  
 
Chapter 8 – Event / Media & Marketing: Finalize Results 
Every day, posts on social media alert sailing fans about the lead competitors and sailing 
conditions affecting competition.  At the end of the event, the Lead Scorer finalizes results and 
prize tables for the awards ceremony.  
 

2.3 Results Team Position Descriptions 

 
Chief Scorer  
 
The Chief Scorer oversees the work of the Results Team providing an external interface between 
CORK’s Events and Operations Groups.  The primary responsibilities of CORK’s Chief Scorer are: 
Review event schedule and participate in CORK Operations meeting during the winter months; 
Plan and oversee recruiting and training of volunteers for the Results Team; 
Schedule the results teams needed for each CORK event;3   

 
2 Sailwave processes a series of finish data by calculating the number of total points for each competitor, then applying 
penalties, discards and retirement codes to the races to show each competitor’s place in the event.  For the first race of a 
series, the Scorer would tap the Score Series button in Sailwave.  A key feature of Sailwave is its flexibility to be configured 
to calculate unusual class rules, handicaps or discarded races into total series results.  
 
3 Typically, one member of the Results Team will be assigned to a specific course and one computer to work with 
exclusively throughout the event.  This means that an event with three courses would require a minimum of three scorers. 
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Provide on-site training and mentoring to all scorers as needed.   
 
Lead Scorer 
 

The Chief Scorer is often but not always the Lead Scorer for an event.  The Lead Scorer is the 
primary Results Team contact for a specific event, is expected to be on-site for the entire event and 
is responsible for setting up the scoring system in Sailwave.  The Lead Scorer to effectively carry 
out the following responsibilities before and during a CORK event: 
a) Work with Event Services to set-up of the Results Room;  
b) Work with IT Support to set-up the Scoring System and configure Sailwave files;  
c) Export Competitor Data from CRMS & Imports to Sailwave 

d) Participate in Event Management meetings every morning to identify any operational issues 
that could affect the quality of Results;   

e) Provide daily briefings at each morning’s All Volunteer Meeting; 
f) Connect with the RO and the Finish Recorder on each course to confirm the process for 

sending and receiving real-time race results as each race is completed; 
g) Oversee the scoring function for the event including assigning courses, classes and related 

responsibilities to scorers; 
h) Receives and investigates Scoring Inquiries, Jury Decisions and other changes to competitor 

data or race results; 
i) Directs entry of Scoring Changes by relevant scorer; and 
j) Collects and tabulates event performance data and prepares report. 
 
Scorer 
 

Each Scorer is expected to know how to score races for the course that has been assigned to them 
by the Lead Scorer.  The Scorer’s responsibilities are as follows:  
a) Assist with Results Room Set-up 
b) Receive Start Line data by email from course Finish Recorder, prints and forwards to Event 

Services for posting to social media; 
c) Receives race Finish data from course Finish Recorder, prints for input to Sailwave; 
d) Enter Finish positions on Sailwave for all the classes on his/her assigned course; 
e) Publish, print and post Provisional Results on the CORK website and Official Notice Board after 

each race; 
f) Enter approved Scoring Changes on Sailwave for the assigned course & classes; and 
g) Create and file Sailwave backups and related course paperwork appropriately. 
 
Senior Scorer 

 
The Senior Scorer is responsible for setting up and scoring a qualifying & final series (split fleets) 
and have an understanding of the advanced features of Sailwave.    
 
Accomplished Senior Scorers will be able to set-up and score all the classes on his/her assigned 
course which may have one class with split fleets and another class with a single series.  On the 
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other hand, when CORK hosts a major World event where there are many boats competing in a 
qualifying and final series of races on one course (e.g. Laser Radial Youth Worlds), only one Senior 
Scorer will be required. 

2.4 Skills and Qualifications 
 
Certain skills and attributes are needed to be able to score successfully.  All scorers should have 
good computer skills and enough experience with Sailwave to score a basic regatta, i.e. one-course, 
one-class.  An ability to focus and attend to details in an open environment, and a solid 
understanding of Windows operating system are desirable assets for all scorers.  
 
Familiarity with sailing is also a desirable attribute for scoring at CORK.  Many good scorers have 
little or no experience with sailboat racing but wish to volunteer because of an interest in this 
sport.  Many other scorers are familiar with another aspect of CORK and interested in contributing 
in another way.    
 
The Lead Scorer is expected to have several years of experience scoring regattas and a strong 
understanding of Sailwave.  As a minimum, the Lead Scorer must know how to set-up and manage 
Sailwave for a multi-course, multi-class regatta with a qualifying and a final series. 

2.5 Experience and Training 
 
As indicated in Chapter 1, the CORK Results Management Manual is the basis for recruiting and 
training volunteers who want to join the CORK Results Team.  To further enhance the volunteer 
experience and ensure the timely and accurate collection, processing and communication of racing 
results, CORK provided two training seminars: 
 

Basic Scoring  
  
This workshop is designed to prepare a CORK volunteer to take on the Scorer’s responsibilities as 
described in Chapter 6.   Basically, the Scorer will learn how to enter race data to the appropriate 
Sailwave file, publish the scored race results on the CORK event website, create and file backups in 
the appropriate folders and address scoring changes.  Pre-requisites for this training are: good 
computer skills, and attention to detail however familiarity with sailboat racing are desirable 
assets.   
  

Advanced Scoring  
 
This workshop is designed to prepare a Scorer to take on the Senior Scorer and Lead Scorer’s 
responsibilities.  The Scorer will learn how to set-up and score a series of races in different classes 
or starts on one course.  Special attention will be given to the set-up and management of scoring a 
qualifying series then a final series of a large class of boats including flight and fleet assignments, 
working with technical rules, managing known Sailwave issues, etc.  Pre-requisites for this 
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training are a combination of a few years of experience on the CORK Results Team and completion 
of the Basic Scoring course. 
 
The CORK Results training program was designed to help volunteers progressively gain 
experience in scoring at CORK.  Both training courses are offered early in the season before a 
CORK event so that the volunteer will have an opportunity to put learning into practice as soon as 
possible.  The training is provided at no charge to volunteers however each workshop participant 
is expected to sign-up for at least one event at CORK. 
 
Scorers are encouraged to become more familiar with Sailwave by signing up to the Sailwave user 
group on the Sailwave site.  Questions posted there are quickly answered by either the authors of 
the product or by the advanced users of the community (See www.sailwave.com Support on the 
website). 

2.6 Sailwave Basics 
 

Successful scoring at CORK depends on the accurate set-up and configuration of the scoring 
system and attention to detail when scoring and publishing results on Sailwave.     
 
Upgrade Sailwave 
 

Although the IT Support team should have managed any updates to CRMS, it’s a good practice to 
check to see if new versions of Sailwave are 
available prior to doing any set up of the 
software by using the Help->Check 
functions in Sailwave. 
 
The software will contact the Sailwave web 
site server and indicate if a new version is available on  
http://www.sailwave.com/category/sailwave   
 

 
 
 
Sailwave Toolbar 
 
Before embarking on the scoring journey, especially in spring after many months of absence from 
the Results Room, the scorer should become familiar with the various pull-down menus and 
functions of the Sailwave toolbar.   
 

Tip:  Ensure that all PC’s use the exact same version of Sailwave to 
avoid corruption of the results. 

http://www.sailwave.com/
http://www.sailwave.com/category/sailwave
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The toolbar has five ‘horizontal bars’ designed to ease access to the various scoring functions.  To 
the right of the Sailwave logo in the top bar typically shows the name and location of the file.   
There are nine functions in the second bar accessible through pull-down menus, but typically the 
scorer uses the first six (from left to right): 
 

File – Create new, open existing files and import competitors’ lists from a .csv file – the suffix 
indicating data that can be transferred into Sailwave.  Shortcuts to most of these functions are 
buttons below ‘File’ at the left of the third bar.  
View – Access and adjust various screens such as columns of data or series properties (property 
bar).  Shortcuts to most of these functions are buttons below at the left of the fourth bar.  A 
Search/Filter box to the far right of this bar allows for selectively displaying competitors and easily 
find competitors should you wish to edit them. 
Edit – Access and make changes to values in cells, competitors’ data, races, etc. Shortcuts to most of 
these functions are buttons at the left of the fifth or bottom bar. 
Publish – Publish on a website or print results, competitors’ lists and prize tables 
Tools – Access Sailwave functions such as ‘sail number wizard’, rearrange recorded places, score & 
rescore.  Shortcuts to most of these functions are buttons at the right of the fifth or bottom bar. 
Setup – Configure the series parameters and scoring system related to the event.  Shortcuts to 
most of these functions are buttons below ‘Setup’ to the right of the third bar. 
 
Becoming familiar with the core functions in the pull-down menu and the shortcut buttons on the 
three bars below the pull-down menu will improve the scorer’s efficiency when the race data 
arrives at the scorer’s workstation and actual data input begins.  Even though there will be 

multiple classes on each course, Sailwave will recognize the class when finish data is entered. 

2.7 Managing Sailwave Files 
 
Sailwave is memory based and only writes the file to disk when requested by the Scorer.  Sailwave 
does not provide an auto recovery of files in the case of a computer failure or file corruption.  
Therefore, careful attention to saving and backing-up is very important. Consistent naming 
protocols, conventions and locations for Sailwave back-up and archived files ensure that results 
can be easily retrieved and reviewed should there be an appeal of the final results.   
 

Naming Protocols 

Tip:  Hover the pointer close to a short-cut button to see what each button icon could do. 
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Before the regatta begins, the Chief Scorer will determine the appropriate naming protocols for 
each event in consultation with the Event Chair.   The IT Support team will set up easily 
identifiable event folders and pathnames on the CORK server (R-drive) corresponding to the name 
of the event, e.g. International or OCR.   
 
Once the regatta begins, the Lead Scorer setss-up the event scoring system and configure Sailwave 
files according to this protocol.   Each event folder will have a Master file with the name of the 
class or classes to be scored.   
 
A scorer is responsible for maintaining all the files for two or three fleets on his/her assigned 
course and workstation.   He/she should become familiar with the file names and protocols before 
the race data arrives from the race committee.  
 
Saving Files    

After entering race data, the Scorer saves results for each race from the Master with a race 
number.  For example, the Sailwave file for first race of the a Viper640 event could be named 
Viper640 Master R1.blw.   Scorers are expected to adhere to the naming protocols for the results 
files assigned to them, and for creating a back-up file at the end of each day.  Every Sailwave file is 
scored and saved on the C-drive of the workstation assigned to each course.  Although memory-
based software runs much faster, the scorer should preserve his/her Results – important CORK 
assets – at several points during the day.  

To safeguard against data loss, the Scorer should regularly save the file to the CORK Server i.e. the 
R-drive.  Sailwave prompts the scorer to save a file when a change is made with a ‘Save needed’ at 
the bottom of the results window.  Saving is done easily by using the keyboard short cut of 
Contr
ol-S 
like 
any Windows application.  

 
Backing-up Files 
 
A backup is a copy of a race results file that may be used to restore the original in the event the 
latter is lost or damaged beyond repair.  At a minimum, a back-up should be created at the end of 
each day.  For complex events such as those with flights and fleets, a backup of the Sailwave file 
should be done more frequently with a date and time included in the file name.  Below are the 
steps for creating a backup of a Sailwave file: 

• Save the file in the folder designated by the Lead Scorer.  
• Exit Sailwave. 
• Use File Explorer to find the Sailwave file. 

Tip:  Avoid using the File->Save As… menu because it may overwrite the current data. 
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• Make a copy of the file. 
• Move or Paste the copy of the Sailwave file in the same folder as the Master file. 
• Rename the copied file by editing the “Copy” part of the file name to the stage of data entry.    
• Here are a few examples: 

o Original file   :2017 North American Championships 
o Paste            :2017 North American Championships – Copy 
o Rename to  :2017 North American Championships – After race data entry 

o Or to   :2017 North American Championships – After race 6 flights 

 

 
Archiving 
 
An archive refers to a single or a collection of historical records specifically selected for long-term 
retention and future reference.  It is usually data that is no longer actively used.  The archiving of 
Sailwave data files is the responsibility of Event Management.  
 
Although archived files may not be actively used, it may be called upon in the case of appeals of a 
Jury decision or to easily create a new series that replicates the properties of an earlier CORK 
event.  For example, the International Optimists regatta – a complex event with many competitors 
in qualifying and final series – which takes place annually.     

  

Tip:  Create a Backup folder within the Event folder to store daily backups. 
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CHAPTER 3 – Event / IT Support: Set-up Regatta 

3.1 Recruit/Train Scorers for Events  
 
In the months leading up to CORK events, the Chief Scorer works closely with Operations 
Management and the Event Services team to identify the properties of each event scoring system 
and to recruit and schedule scorers each event.  The number and qualifications of each scorer 
scheduled for each event depends on the number of courses and classes of boats on each course, 
the number of boats in each fleet and fleet splits (see Chapter 5 for details).  If two classes of boats 
each on a separate course will be racing qualifying and final series for example, two Senior Scorers 
will need to be recruited and trained. 
 
Below is an example of a Results Team Plan for scheduling scorers for CORK’s 2019 events.  
 

 
* Assumes that each scorer will be trained and on-duty for the entire event.   

   
Certain classes – e.g. International Laser Class Association (ILCA) – have specific scoring protocols.  
Sailwave is particularly flexible for adapting to different class requirements and situations.  When 
scheduling scorers, it’s important to also review class rules to identify any scoring requirements – 
such as unique penalties or age categories – which must be configured into Sailwave during the 
set-up phase.  The Notice of Race (NOR) and Sailing Instructions (Si’s)will often refer to scoring 
requirements that come from the class rules.  
 
Appropriate and realistic set-up of the regatta files on Sailwave is a critical to a successful scoring 
experience.  If not set-up correctly, even accurate entry of race data could lead to incorrect results 
and a plethora of scoring inquiries from competitors – not a good thing!   
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CORK has determined that the number and type of scoring inquiries are the key performance 
indicators (KPIs) for each event.  See Chapter 7 for information on scoring inquiries and Chapter 9 
for details on performance measurement.  

3.2 Complete NOR and SI 
 
A thorough understanding of the scoring provisions in the Notice of Race (NOR) and Sailing 
Instructions (SI’s) is needed to accurate set up a series of races.  The NOR and SI’s provide 
information – aka ‘Scoring properties’ in Sailwave – on how many races will be run, at what 
number of races will a result be discarded (i.e. dropped) and what scoring method and penalty 
codes will be applied to each course and class.   
 
The NOR and SI’s should be available long before racing begins.  Typically, the Chief Scorer will 
prepare a summary of the scoring properties to be configured to Sailwave in an Excel spreadsheet 
called NOR & SI Review - see example below. 
 

 
 

3.3 Set-up Results Room  
 

One or two days before the regatta begins, CORK’s IT Support group updates hardware and 
software (e.g. CRMS, Sailwave).   At the same time, the Chief Scorer confirms passwords for access 
to the CORK Server, Website pathways and as well as the logos required for the event and inform 
the Lead Scorer.  The Lead Scorer will contact members of the Results Team to advise on event 
information and scoring requirements, confirm assignments and availability for setting-up of the 
Results Office and Sailwave files.    
 
Results Room Set-up involves positioning room dividers, connecting computers for as many work 
stations as needed for the size of event and organizing other office equipment such as boards, 
binders, file folders, pens and markers.  File folders to receive on-water race records by fleet/class 
name are also set-up in the Results Room. 
 
Appropriate filing of important Scoring System regatta documentation – both electronic and paper 
– promotes efficiency and contributes significantly to the success of the regatta.   A well-organized 
Results Room considers the flow of paper from race officers and jury as they come off the water.   
 

Sailing Instruction Notice of Race Comments Scoring code Action Flights /Fleets
Score change 

race to race

Check after Jury 

action

Non Standard 

tiebreaker

1.3 1.3  RRS App P re rule 42  

5 poss Qualifying & Final Series X

7.2 6.2 number of races (i14 LD) (DND)

1.5, 17 Arbitration offered ARB

15.2 time limits / average? TLE?

16.8 posted prior to close protest

18.3 discards - 5, 10

18.4 course notice board?

19.2, 19.4 sign-out/sign-in CH10/CH20

19.6 RET

August 18-23 CORK OCR / SC Seniors / Finn East Champs (3 days)
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Easy identification of paper files folders is particularly important for checking finish data and 
making scoring changes at the end of each day.  Each workstation should have a binder with 
relevant course name & fleets for filing paper documents such as Finish Sheets, Start Data, etc. 
which are received from the Finish Team.  At the end of each day, the Scorer is responsible for 
filing this documentation.  The course binder is an important reference for both Race Committee 
and Jury should scoring changes be required as a result of redress or protest hearings.    
 
The Lead Scorer is responsible for maintaining another important reference - a binder for filing 
documents relating to various Scoring Changes.  This binder typically has four sections: 

• Scoring Inquiries – Competitors who believe that they have been scored incorrectly may 
complete an inquiry form available from the Jury desk requesting the Race Committee to 
review and correct that score. 

• Jury Decisions – Forms identifying scoring changes resulting from Jury decisions for on-
water infractions or as a result of a protest or redress hearing/  

• Sign-out / Sign-in Penalties – Registration may complete a form identifying competitors 
who are penalized if they do not sign-out when leaving for shore nor sign-in when they 
return to shore. 

• Change of Information – Competitors who make a correction to registration data or change 
crew or equipment information will file a Change of Information form.    
 

3.4 Set-up Series in Sailwave 
 
Taking time to configure the regatta’s scoring fields accurately on Sailwave is the responsibility of 
the Lead Scorer (or the Senior Scorer in the case of split fleets – see Chapter 5).   To score 
efficiently however, every scorer should be familiar with the set-up process as outlined below.   
 
From the File menu, select a New Series option and enter the basic data such as initial number of 
races and number of competitors.  Do not use a pro-forma series because it may not have the 
correct properties unique to the event.    
 
Since each course 
has different 
classes which 
may have 
different file 
requirements, 
new series file 
should be set up 
for each course 
regardless of the 
number of classes on the course.  Initial setup for multiple classes is the same as for a single course 
event, then multiple copies will be created, each saved with the name of class to be scored e.g. 
Laser (class). 
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The approach to setting up a regatta in Sailwave is roughly as follows: 

• Setup->Global Options – configures the general user preferences for the series   
• Setup->Scoring system – creates and configures the scoring systems for the series such as 

scoring codes (e.g. ARB for arbitration is a 20% penalty), discard profile, etc. 
• Setup->Series properties – specifies how results will look when published on the website  

3.5 Configure Global Options 
 
There are several scoring system options, not part of the specific database files on Sailwave, which 
must be set up at the time of initial installation of the software and after any upgrades to Sailwave.   
These options are found under Setup->Global Options.   Values to use in the Global Options screen 
are as follows:  
 

Startup 
▪ Select ‘Do Nothing’ 

View 
▪ Font size – 8pt 
▪ Background image – set to 

Sailwave logo (e.g. swlogo80.gif) 
▪ Select Display ranks as 1st, 2nd, 3rd 

etc. instead of 1,2,3 
▪ Note the primary sort prefix at 

bottom of screen 

Language  
▪ ANSI (i.e. English) 

FTP4 
▪ Set to the website to which 

results will be published 
▪ Each series should have its own 

FTP accounts to improve security 
of the records.   

▪ Obtain values from CORK IT 
Support Group 
o Server – the IP address of the results 

FTP server 
o Base URL – the location to which 

results will be sent 
o Port – the IP port on the server 

 
4 File Transfer Protocol (FTP) is a set of rules used to transfer computer files between a client and server on a computer 
network 
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(typically default of 21) 
o Username and Password – the login credentials for the FTP server 

SMTP server 
▪ Use only if Sailwave will be emailing out results 
▪ Get values from the Event / IT Support Group 

Folders, Colours, Code/Discard Formatting/Upgrades/Importing 
▪ Use default 

 

3.6 Setup Scoring System 
 
Many specific scoring requirements noted in the NoR and SI’s are configured under the Setup-
>Scoring System menu.  
 

     Race scoring 
The first tab indicates the scoring 
method that will be used for the event 
which is usually provided in the first line 
of the Scoring section of the SI’s.  
Typically, the ISAF Appendix A standard 
low point system is used but this may 
change depending on the event.  Nothing 
else needs to change on this first tab.  
 

Scoring Codes 
The scoring codes will be used when 
entering scores for competitors who Did 
Not Finish (DNF), Did Not Compete 
(DNC), penalties etc. 

 

Series Scoring 
There are two values under Series 
Scoring tab – Series tie resolution, 
Discard profile.  Both are used to 
calculate the race scores for the series.  
Default values for tie resolutions are as 
specified in Appendix A 8.1 and 8.2.  Any 
change to these defaults would be 
defined in the NoR or SI’s 
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Discards 
The ‘Discard profile’ is at the bottom of the Series scoring tab. The point(s) at which the discarded 
races and the number of drops is 
identified in the SI’s.  To set the profile, 
indicate series of 0’s to indicate how many 
races have 0 drops, following by 1’s to 
indicate how many races have 1 drop, 
then 2’s for how many races get two 
drops. Here is an example for a regatta 
with 13 races and allowing for one drop 
after 5 races have been run. 
 

App LE Addendum C 
The options under this tab are used when 
CORK runs a qualifying and final series.  
Since this happens frequently at CORK, 
set-up and scoring details are provided separately in Chapter 5.  
 

3.7 Setup Series Properties 
 
The Series properties fields define how the results will look when published on the CORK 
website.  To provide a professional image, it is important that values such as the event & venue 
name, website and burgee, Sailor ID and nationality are set up carefully using high quality and 
appropriately proportioned images.  
 
The results and competitors lists published on the web show both CORK and sponsor logos.  The 
logos are filed within the website directories – http://www.cork.org/logos.    To publish correctly 
on the CORK website, these files will have to be stored in the directory where the Sailwave race 
file (the “.blw” file) is saved.  Before beginning the Series Properties set-up, obtain the folders, path 
and file names from the CORK Event/IT Support Group. 
 
Follow the steps below to set-up the Series properties: 
 

Event and Venue Name 
▪ Event – Enter the logo filenames with the full directory and folder path.  As mentioned 

above, these files must be stored in the Sailwave race file folder.     

▪ Event Burgee – Points to the properly formatted image that you want to appear on the 
upper right corner of anything published 

▪ Venue – Names and image/logo used to represent the host venue (e.g. CORK) 

http://www.cork.org/logos
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▪ Venue Burgee – Points to the 
properly formatted image/logo 
that you want to appear on the 
upper left corner of anything 
published. 

 
Note that the logo filenames are 
followed by a space and then a 
“width=xxx” command where xxx 
refers to the number of points of width.  
There may be some trial and error 
using the “width = ___” command to 
make printouts look balanced on the 
printed results.  The width assigned to 
the logo can also refers to a percent of 
the page.   
 

 

Publishing 
Many regattas hosted by CORK are sanctioned by World Sailing (formerly ISAF).  Check-off or add 
values in the ISAF Sailor ID section to ensure access to details about the sailors in the published 
results.  Also, check-off Publish nationality field as hyperlinks to flag.  The default should be set for 
small flags. 
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CHAPTER 4 – Registration: Import Competitors 
 

4.1 CRMS Export 
 
Information about competitors that have entered and paid a fee to race at a CORK event is 
maintained in the CORK Race Management Software (CRMS).   CRMS is used to register 
competitors and manage registration data including changes in crew and equipment that may 
occur during the regatta.  At a point before the regatta starts, competitor data must be exported 
from CRMS and imported into the Sailwave file(s) to complete the preparation stage of the scoring 
system.   
 
It is important to work closely with the Registration Team located in the CORK office the day 
before the event.  Although many competitors register and pay online, there are often late entrants 
or last-minute changes to crew or equipment the day before racing begins. The Registration Team 
will advise when most of the competitor data in CRMS is complete and ready for export.   
 
If the CRMS export is done too early, the Scorer will need to manually add late entrants or last-
minute changes to crew or equipment to the Sailwave file(s).  All subsequent changes to 
competitor data must come from an official Change of Information request sheet from Registration 
in the CORK office.  No changes to competitor info can be done by the Results Team until this form 
is received from Registration and filed in the Scoring Change binder.   This procedure ensures that 
both CRMS and Sailwave systems are kept in sync throughout the regatta.  
 
Note: An exception to the above could be a boat that doesn’t meet the requirements of entry, e.g. 
measurement discrepancy.  That boat must be removed from Sailwave, but probably should stay 
in CRMS for record keeping.  It is important to confirm this information with the Registration 
before removing a competitor. 

4.2 Run Master Sailwave File Generator 
 

To obtain the competitors data in a format useful to Sailwave, the exported file must be 
manipulated post export from CRMS to get it into the format required for import into Sailwave.   
The steps involved in setting up the competitors list are as follows: 
 
1) Identify the appropriate .csv file exported from CRMS from the CORK Server (R-drive) as 

stipulated by Registration in CORK office  
 

2) Open the .csv file in Excel 
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3) Find the Master Sailwave File Generator5 and open it in Excel.  This file has a Macro that 
remaps fields from the columns used in the CRMS Export to the columns to be used in 
Sailwave.  

 
4) Clear the data from the existing fields in the File Generator if they are populated. 

 
5) Copy the appropriate export data from the .csv file (step 1) into the File Generator 

spreadsheet and enable the Macros. 
 

6) Type ‘Control – I’ to remap the CRMS fields to those needed by Sailwave. 
 

7) Open a Notepad file. 
 

8) Paste the CRMS fields into the Notepad file (Ctrl-V)   (The required data is already on the 
virtual clipboard.) 

 
9) Save the Notepad file with a  .csv extension. 

 
10) Go to Sailwave and click on the menu item File->Import Competitors from a CSV file and 

import the file created in step 7.  This will populate the main window of Sailwave with the 
competitor information. 
 

11) Examine the resulting data and complete remapping data fields if needed but normally they 
are already set up fine. 

 

4.3 Complete Data Fields 
 
Update Column Headers 
 
Column headers in the competitor list in Sailwave will need to be changed for fields to match the 
values of the data imported.  For example, the Medical column in Sailwave might contain City data 
from CRMS so change the header name to City to help the user understand the data.  Note that the 
internal field containing the data will still be the same as at import regardless of what the column 
name was changed to, so in doing publications you would need to select Medical to see the City 
data. 
 
Ensure that the order of the columns from left to right conforms with CORK’s preferred ‘look’ for 
published results, for example: 
 
Rank Nat SailNo Helm Name Crew Name Race cols – R1, R2... Total Net Club City 

 

 
5 This Excel Macro was developed by Peter van Muyden for CORK to facilitate the mapping of fields from CRMS to Sailwave.  
It also contains logic which improves the ‘look’ of the results. 
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Adding a Competitor 
 

To add a new competitor who registered after the import to Sailwave, use another competitor’s 
entry as a template by selecting a competitor in the same fleet.  Then click the 
‘New like’ button (at the left in the bottom of the Sailwave toolbar) to create a 
duplicate of the one selected.  
 
Important!  Edit the information for the competitor just created immediately!  
Double click on the duplicated entry 
and edit ALL the fields to make sure 
that none of the original competitor’s 
data is used for the new entry.  Take 
special care to edit both Helm and 
Crew entries.  

 
Editing a Competitor 
 

If a competitor Change of Information 
form is received, a competitor’s 
information (e.g. Change sail number, 
name or fleet) may need to be edited. 
To edit competitor information, 
double click on the competitor’s 
name and edit fields as required, e.g. 
SailNo, Crew Name, etc. 
 

Finally, select ‘Hide fields unused by all competitors in the series.  This will make it easier for 
editing and publishing results. 

4.4 Setup Races and Starts 
 

Set up Number of Races 
 

The maximum number of races in the regatta, as indicated in the SI’s, can now be confirmed.  This 
is most easily done using the ‘New’ button about midpoint on the bottom bar of the toolbar (next 
to ‘Sail num wizard’): 

▪ Click the ‘New’ button and add the highest number of possible races 
amongst all the fleets and then add two more to allow for any races 
that might have to be re-sailed, i.e. if the Laser Radials are scheduled for 10 races, add 12 
Races. 

▪ Uncheck the View->Hide all un-sailed races menu item so you can see the races that you 
just added. 
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Set up the Starts for the Races 
 

Any single racing course at CORK may have several ‘starts’.  If there are few boats in two similar 
classes (e.g. i420, C420), they may be combined in one file with two starts (one per class).  A ‘start’ 
may be named for the class racing in a regular series.  Two or three ‘starts’ may also correspond to 
the same class which has been split into flights in a qualifying series.  For example, it is common to 
have one start (e.g. i420) and a split class of two starts (e.g. C420) on a single race course at CORK.  
See Chapter 5 for details on setting up and scoring a split series. 
 
 
 
 
To set up the first race, we first need 
to add competitors to the race. This 
is done by using the R1, R2 etc. 
columns in main window.   
 
To set up a start: 

• Right Click R1 and select Edit 

Race. 
• Enter a Name and day for 

the race (we will enter time 
later once we have results). 

• Click the New button in the 
Starts section and add a 
start.  

• Select Competitors for that 
fleet using Query menus 
(e.g. Fleet = Lasers). 

• Leave the name as Start 1. 
• Repeat creating a new start 

for each fleet sailing on 
your course for the first 
race. 

 

 

Note that ‘Starts’ for the other 
races can be copied from the Starts 
setup for Race 1.  To do this, select 
Edit race for R1 and use the Copy 
Starts box to add the Race that you 
want to copy the R1 starts to.  It is 
important to understand that you 
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are copying the starts from R1 to a new race. 
 
Edit a Start 
 
Occasionally, the SI’s may specify that certain race results or starts cannot be discarded, e.g. a 
distance race.  The window below shows how to make a race ‘not discardable’.   
 

Backup Master File 
 

Save the Sailwave file at this point and make a Master copy to have a backup should any of the 
following steps cause problems.  Confirm with Lead Scorer for the proper location and names for 
files for your regatta. 
 

Set up Printer 
 

Make sure the default printer from the Windows Start Menu -> Devices and Printers is set to 
the Kyocera printer designated for scoring and set it up to print in black and white. The default 
printer may change from year to year or event to event, so check with the IT Support group before 
completing this step. 

4.5 Scratch Sheets 
 
A scratch sheet is a list of competitors with sail 
numbers by course and class which is updated to 
reflect changes in Registration.   A separate 
scratch sheet for each class is required, sorted in 
ascending sail number order by clicking on the 
title of the ‘SailNo’ column.   
 
Competitor List 
 

To create a competitor list in Sailwave, first select data fields that you want on the list from the 
Columns menu - see example opposite.   
 
This is done by right-clicking on the relevant column title – e.g. SailNo, HelmName – for a pop-up 
menu that allows you to choose to view the content data on screen and when publishing. 
 

 

Next, select Publish -> Competitor list … from 
the Sailwave pull-down menu to enter desired 
the competitor list options:   

- Change the 'Title’ field to 
display the Class name and 
date.   
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- Select the relevant class from 
by clicking on the ‘Select competitors’ button  
 
 
Then select ‘Next’ to see the ‘Publish web page…’ 
window – see next page.   
 
 
At this point, select the ‘Preview’ button to view, 
modify and print the competitor list.  Print the 
competitor’s list from the ‘Preview’. 
 

Important!! Do not hit the ‘Publish’ button at the 
bottom of the bottom of this window as this is used 
for publishing to the web. 

 
 
 
An example of the Competitor’s List is provided below.  Columns could be added for notes or for 
Sign-out/Sign-in sheets. 
  

 
For most classes, the competitor list should be prepared the evening before and made available in 
the area near the Results Room where Recorders pick-up the race official forms needed for on-
water recording (see Chapter 6 for more information on official forms).   
 
Unique Sail Number List 
 
Scoring is especially challenging for large fleets with sail numbers are 6-7 digits long, e.g. 
Optimists, Lasers.  Duplicate sail numbers may occur for boats on the same course or the same 
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fleet.  Duplicates in the last 5, 4 or 3 digits of the sail number may occur.  Often 3 or 4 numbers are 
all that the finish team can write down especially when several boats finish together.   
 
A Macro-enabled spreadsheet called Unique Sailnumber is used to identify duplicate sail numbers.  
Unique Sailnumber gives the finish line crew a simplified list of all sail numbers showing where 
there are duplicates at the 5, 4, 3 and 2 digit-level.   This file can be found in the CORK-scoring 
Dropbox file -  https://www.dropbox.com/s/kyqz7c615xhno9o/Unique%20Sailnumber.xlsm?dl=0 
 
The steps for producing the Unique Sail Number list are as follows: 
 

1) Review the scratch sheet to identify if there are two boats with the same last 4 digits. If so, 

notify the Finish Team that at least 5 digits must be recorded. 

2) Find and open the Macro enabled Excel spread sheet Unique Sailnumber.xls  

3) Export from Sailwave via Export Series Summary to Windows Clipboard, choosing only 

the Sail No to export since the Finish Team only needs the numbers. 

4) Clear the populated in the Unique Sailnumber.xls Input Sheet. 

5) Paste the exported data into Cell A1 of the Scratch sheet. 

6) Remove the field cell with the header. 

7) Copy the data again from Scratch and paste into Cell A1 of the Input Sheet. 

8) Enter the title in Cell C2 and hit return (e.g. CORK Fall Laser Standard). 

9) Click Start Process. 

10) Once it is done go to Last 4 report and print out two copies for the Finish Team. 

11) It will highlight any numbers that duplicate for the last 4 digits. 

 

Sign-Out/Sign-In Lists 
 
Sign-Out/Sign-In lists are laid out in front of the CORK office for sailors to initial when they leave 
to compete on the race course and when they return.  The signing out & in procedure is a safety 
precaution to ensure that any competitor that leaves to race also comes back to shore.  It is 
required in the SI’s, therefore competitors who do not sign may be penalized when scored.   
 
The lists are typically printed by fleet and in sail number order from CRMS and managed by the 
CORK Office.  The Event Co-Chair signs off on the lists and produces the penalty form used by the 
Results Team when scoring.  Most RO’s prefer the list produced by CRMS.    
 
However, the Sign-Out/Sign-In list can also be produced from Sailwave as follows:  
  

1) Create a Sign Out/ Sign in list from the Publish->sign on-off sheet pull-down menu. 

2) Use the default fields that are displayed if desired.  If you want it for specific fleets, use 

Select Competitors to select the appropriate fleet. 

3) Click Next. 

4) Publish to Destination Default Internet Browser. 

https://www.dropbox.com/s/kyqz7c615xhno9o/Unique%20Sailnumber.xlsm?dl=0
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5) Print the resulting web page in black and white 

 

If a competitor does not sign-out, the CORK 

office will provide the Results office with a 

form indicating that a penalty should be 

applied to the competitor’s first or last race 

that day.   See Chapter 6 for more 

information about entering sign-out/sign-in 

penalties in Sailwave. 
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CHAPTER 5 – Split Fleets: Qualifying and Final Series   
 
CORK regattas with large numbers of competitors are often divided into a qualifying and a final 
series of races.  There may be two to three courses where some groups of competitors are racing 
in qualifying series, and others in standard series.  During the qualifying series, boats are divided 
into groups called flights.  During the final series, boats are divided into groups called fleets.  
 
It is critically important to identify which competitors are racing in qualifying series in Sailwave 
and to know how to manage each day’s results carefully.  Race officers assigned to a course may 
need to manage races of hundreds of competitors, some groups racing in qualifying and final 
series or split fleets, and some in a regular series.  The process of assigning flights is repeated at 
the end of every day (after scoring penalties and other changes have been applied) for the next 
day’s races.  

5.1 Summary of Steps 
 

In the Qualifying Series, flight assignments are done at the end of each day and flights are scored 
as one group (steps 1 & 2 below).  After the qualifying series is completed, competitors are 
assigned to their fleets based on their ranked position of their flight scores.   Below is an overview 
of the setup and scoring processes related to split fleets: 
 

1.  Setup the Qualifying series: 
a. Set up the Series properties. 
b. Set up the Scoring system. 
c. Create races and starts. 
d. Add the competitors. 
e. Assign flights for the first day's racesall the qualifying race days. 
f. Publish the first day's flight assignments. 

3. At the end of the last day of Qualifying series, prepare for Final series of races: 
a. Assign fleets for the final series of races. 
b. Publish fleet assignments for finals. 
 

2. Each day of the Qualifying series of races: 
a. Enter the day's results. 
b. Score the series as one group. 
c. Publish the results. 
d. Assign flights for the next day'srest of the qualifying races (except at the end of the 

last day of qualifiers). 
e. Publish the next day's flight assignments (except at the end of the last day of 

qualifiers). 
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4. Each day of the Final series: 
a. Enter day's results. 
b. Score the series by fleet. 
c. Publish the results. 

 

5.2 Setup and Scoring Flights for the Qualifying Series 
 

The process of assigning flights is repeated at the end of every day (after scoring penalties and 
other changes have been applied) for the next day’s races. 
 
Setting up the Series and Scoring System 
 
Begin the process of setting up the Qualifying Series 
Setup by selecting the Setup dropdown menu.   
Some functions are similar to set-up for a regular 
series of races.  Note differences below:  
 
Global options are unchanged from what was 
presented in Chapter 3.  
 
The User Interface… sets up the race for the 
qualifying races. Check the boxes for “Extra 
competitor fields in Edit+Competitor”, “Qualification 
profile”, “Split Starts allowing multiple 1sts, 2nds etc.” and “Appendix LE Addendum C”. 
 
The Series properties… no difference from the 
description in Chapter 3. 
 
The Scoring system… menu has many features 
unique to the qualifying races.  
 
The Prizes… selection is similar to what is used 
in conventional races. 
 
Create Races and Starts 
 
When setting up for a qualifying series of races, 
the sailors are scored as one group. This means 
that after the first race that has three separate 
starts, that there will be three 1sts places, three 
2nd places and so on.  After the second and third 
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qualifying races, the placings will look more conventional with fewer shared rankings.  
 
By selecting the Scoring System… will 
bring up a menu titled Edit scoring 
system with a number of tabs. In the first 
tab, Race scoring, select the box “Allow 
multiple 1sts, 2nds etc” in the lower right 
area in the Split starts box. 
 

Scoring Codes 
 
It is quite likely that each fleet in a 
multiple start race will not have the same 
number of boats. To compensate for this 
when scoring, boats that receive scoring 
penalties (DNS, DNF, or percentage 
penalties) have to have the penalty 
calculated on the number of boats in the 
largest fleet and not necessarily in the 
fleet size that the competitor is sailing in.  
 

In the illustration at right, the Scoring 
codes have been selected. There are 
penalties based on the number of boats in 
the race – DNF, BFD, DSQ, DNE, OCS, RET 
etc. – that have to select the maximum 
number of boats from the largest race.  
 
To do this, select the Scoring Codes tab 
and highlight the code you wish to modify, select Edit on the right-hand side and you are 
presented with the ‘Edit scoring code’ screen.  
 

Select “the number of boats in the biggest 
start in the race”. Ensure that you add the 
numeral “1” in the value box at the top (or 
what value is provided by the SI’s or NoR 
instructions.) 

 

In the case for a percentage-based scoring 
code, select the “finishing place + N 
percent of the biggest start in any one 
race”. For a 10% percentage, put the 
number “10” in the Value box at the top 
of the screen.  To finish the code 
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modification, select the “OK” button to exit the menu.  
 
It is a good idea to confirm that these scoring codes are producing the expected results during the 
course of the race. For the most part these selections will work but sometimes you may have used 
a manually inserted value to get the desired result.  
 
Discard Profile 
 
In the Edit scoring system menu > Series scoring tab, set up the discard profile as per the SI and 
NoR instructions.  This is the same as in Chapter 3.   
 
But there’s another step for split fleets.  In the Edit scoring system > App LE Addendum C tab, 
do the following: 
• Select the “This series comprises qualifying and final races” box 
• Select the “do not recalculate qualifying race points when at least one finals race has been 

sailed“ box 
• Enter the appropriate number for the 

“The first final race is race” 
 

Note that some classes like the Laser 
require a certain number of races to be 
completed before a final race may be 
dropped.   
 
Add competitors 
 
At this point, the competitors can be 
added to the Sailwave file. This process is 
described in Chapter 4. 
 
Set-up Initial Flight Assignments 
 
The initial flight setup is based on 
rankings provided at the time of registration or another method (i.e. last name, country) 
determined by the course race officer in consultation with the Event Chair.  After the first day of 
racing, the rankings calculated by the Sailwave and shown in the ‘Rank’ field on results will be 
used to divide the boats into flights for the following day.    
 
The number of splits depends on the number of boats registered – e.g. a total of say 148 
competitors typically would be split into three flights, with each group having a fairly equal 
number of competitors – say, 50, 49, 49. 
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To set-up flights, select the Tools menu > 
Flight assignments… which brings up the 
menu at left. 
 
In this regatta example, there will be 6 
qualifying races and 4 final races. This will be 
the initial flight assignment, so all 
competitors will be selected.   
 
Since there will be 6 qualifying races, flight 
assignments are applied to races 1 through 6. 
 

 
In the “Assign these flights” box, create a list of 
flights by flight colour which is typically set by the 
SIs or NoR.  A flight list may also be created by 
selecting the ‘Populate list’ button, which may 
have the desired colours already set up as a 
selection.  
 
The SIs or NoR should state the assignment 
method – if there is no instruction, consult with 
the RO to find which method they would like to 
use.  Finally, it is appropriate to select the View 
flight assignments after the selection. Click on OK 
to complete the initial flight assignment. 
 

Assign flights to races 

At this point, races must be identified as the 

qualifying or final series.  Place the cursor on the 

first race and right click to get the 

Edit race… box. 
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Then left click on the Edit race… box to see the Edit race screen above.  Change the Name of race 
from R1 to R1/Q1 for first qualifying race. 
 
Next, left click on the word Edit …  to see the 
Edit start menu. 
 
In this example, there will be 3 starts – one 
each for the Yellow, Blue and Red flights.  
 
Click on the Select competitors button to 
identify values for each division. 
 
From left to right, flights are assigned 
starting values as follows: 
• Click on the top left down-symbol to 

select Flight as a category. 
• Set the next field is set to “=” 
• Click the next field down-symbol to 

select the Flight colour – in this case, 
select Yellow as the first 
start colour 

• Click on OK and the first 
start will be entered. 

 
Next, click on the New button 
(below the Edit button) to set 
up the second start.  This will 
automatically set up Start 2 
using the previous ‘Flight 
equals Yellow’ as a starting 
point.  Edit this start by 
selecting competitors for the 
Start 2 to be Blue in this example. Click on OK to save this Start 2 setup.  
 
Repeat the process to setup Start 3 as Red. Fill the Copy starts box with races 2 to 6 (2-6) or the 
number of qualifying races. Press the Copy starts button. Press OK. 
 

At this point, left click on the R2 to get the Edit race box and left click on it. Rename the race from 
R2 to R2/Q2 to identify the 2nd qualifying race. Click on OK. 
 
Use the same process to rename R3 through R6 as R3/Q3, R4/Q4, R5/Q5 and R6/Q6.   
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The flight assignments at this point look 
something like the screen at left.  Note 
that the display of flight assignments can 
be selected from the drop-down list to 
the right of the Flight Assignments box. 
 
  
 
 
 
 

   
 
During qualifying series, all flights 
are scored as one group.  This means 
that all flights must have completed 
the same number of races before the 
next day’s flights can be assigned. 
 

Posting Flight Assignments 

During the qualifying series, flight 

assignments are published on the 

CORK website at the end of the day 

for the next day’s races.  Typically, 

the flight assignments sheet shows 

sail number, helm name, nationality, country code and flight colour.  But this may vary depending 

on the event so it’s a good practice to check with the course race officer.  The flight assignments 

are printed from the website and posted on the official notice board.  Flight assignments should 

never be included on the results, sign-out/sign-in sheets or other print outs.  The onus is on the 

competitor to pick up his/her correct flag colour each day.     

Scratch Sheets 
 
A separate scratch sheet for each flight should be prepared using the Unique Sail Number Macro – 

i.e. where the sail numbers are presented as last 3 numbers or last 4 numbers to check for possible 
duplicate conflicts.  Refer to Section 4.5 for the process for generating scratch sheets using the 
Unique Sail Number Macro. 
 
Scoring Qualifying Races 



 

 
CORK RESULTS MANAGEMENT MANUAL VER.10  

© 2019 CORK 

36 

When race data is received, the first race is entered using the Sail num wizard (see Chapter 6).  

When all the race 

data is in, the Score 

series button is 

clicked.  Choose the 

option “Score all 

competitors as one 

group” and ensure 

that the “Sort results 

by field after 

scoring” check box is 

left blank - NOT 
checked.  

 

 

 

 

 

 

Publishing and Posting 

As described in Chapter 6, after the scorer has checked the race data entered and all errors and 

omissions have been cleared up, publish the results on the CORK website, and post paper copies 

for the official notice board and the Results Room results board.  Ensure that the published results 

have the identifying fields that are requested by CORK and the boat class, using the logos as 

required. The presentation may also have the highlights on the 1st, 2nd and 3rd positions.   

Reassigning Flights 

The process of assigning flights is repeated at the end of every day (after scoring penalties and 

other changes have been applied) for the next day’s races. 

In this example, there were 3 races on day 1 and 3 more qualifying races on day 2.  At the end of 

day 1 when the race 3 has been published and any challenges, protests or inquiries have been 

resolved (see Chapter 7), it is necessary to reassign the flight colours to the competitors – this 
time based on day 1 results.  

The process for reassigning flights is to: 

• Click on Rescore or sort by Rank – the results should be the same.   
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• Using the Flight assignments selection from the Tools drop down menu, select all 

competitors. The new flight assignments will apply to the next day races, races 4 to 6 in this 

example.  

• The same flight colours are used as is the assignment method. Click on OK.  

Before leaving for the day, the scorer is expected to publish the new flight assignments on the 

CORK website as well as to the official notice and Results Room boards.  In addition, new Sign 

out/Sign in sheets and Unique Sail Number lists with the new flight assignments should be 

prepared for pick-up by race officers the next morning. 
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5.3 Setup and Scoring Fleets for the Final Series 
 

Continuing with the series example, the next day is last day of the qualifying series and races 4 

through 6 will be run.  Note that all flights must have sailed the same number of races during the 

qualifying series – if one flight has sailed more races than the other flights, then the ROs will be 

required to say which  race will be dropped (or provide some other method) in order to equalize 

the accumulated race scores.  

Before beginning the process 

of fleet assignment, the scorer 

needs to confirm that two key 
instructions are intact: 

• Verify that the “The 

first finals race is race” entry is 

still correct in the App LE 

Addendum C tab on the 

Scoring system menu.  

 

• Ensure that the “Do not 

recalculate qualifying races 

when at least one finals race 

has been sailed” box is still 

checked. 

 

Assigning Fleets 
 

After all scoring changes resulting from protest hearings competitor inquiries have been resolved, 

the qualifying races are complete and the competitors are to be assigned to gold, silver and bronze 
fleets for the final day of racing. 

In this example, there will again be three groups but each group will be scored as a fleet rather 

than as one group.  There are different numbers of competitors in the finals for each fleet:  Gold 

fleet will have 7 competitors, 6 competitors in 

Silver and 6 competitors in Bronze.  If the 

numbers of competitors don’t split evenly, it’s a 

good rule to assign the largest number of 

competitors to the Gold fleet.  

There is more than one way to accomplish this 

split – the method that will be used will first set all 

This example uses a low number of competitors 
for simplicity; a typical CORK regatta could have 
100 or more sailors.  When setting the fleets, the 
Gold fleet will have the greatest number of 
racers – a normal split for 100 boats might be 34 
Gold and 33 of Silver and Bronze.  Ask the RO 
before finalizing the  numbers in each split.   
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competitors to Gold fleet. It will then set all competitors ranked 8 or greater to Silver. Finally all 
competitors ranked 14 or higher will be set as Bronze.  The process is as follows: 

1) Click on the Tools drop down menu. 

Choose the Set competitor field... 

 

 

2) Setup all competitors in Gold Fleet. Ensure 

that the Field to change box is set for Fleet. The 

Action box will be to set the value for Gold – it 

may be necessary to enter the word Gold in this 

box or it may already be there from a 

previous race.  
 

3)  At this point, there should not be any 

previous entries in Fleet.  But by selecting 

the Operation ‘Replace existing’ any 

unexpected entries will be cleared.  Then 
click on OK. 

 

The set-up for the Silver fleet is similar to Gold.  

But this time it is necessary to select competitors whose 
rank is 8 or greater.  When setting up the selection in 
the Select competitor use the drop down to get the 
“>=” choice.  Change the Set this value field to Silver. 
 
The setup is the same for the Bronze fleet except that 
the Select competitor choice 
will be 14 or greater. 
 
All competitors will now be 
assigned to fleets.  
Accordingly, the Fleet column 

is populated with the appropriate colour and the Flight column is now 
redundant. 
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As mentioned earlier, the finals races are scored by Fleet and not as one group.  Unlike the 
qualifying races, the fleets do not have to sail the same number final races.   
 
Note that Scoring codes need to be changed so that they refer to number of boats in each fleet – 
since the fleets are scored separately there is no need to get the “largest number of boats in any 
start” condition.  
 
This will have to be done 
for both the fixed value 
scoring codes and the 
percentage value scoring 
codes. 
 

 

 
 
 
 
Recreating Races and Starts 
 

Several changes are needed to reflect the shift to the Final Series as follows: 

• Reset the titles and starts of the final races need to be reset to F1, F2… by right clicking on 

the R7, R8… race tabs. Right click on the first final race again (F1 in this example). 

• Click on the Edit button and then click on the Select Competitors in the Edit start screen 

to set up the Start 1. 

• Select Fleet from the Select Competitors screen, then select Gold for the first start. 
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• Click on the OK button to get back to the Edit race screen.  

• Set up start 2 by clicking on the New button and then the Edit button the second start. This 

will allow you to select Fleet equal to Silver.  

• Click on the OK buttons set start 3 for Bronze in the same fashion.  

• Click on the Copy starts button for races 8 to 10 in this example. Edit the races 8 to 10 to 

change the headings to F2, F3 and F4 in this example. 

As with flights, the fleet assignments must be published to the CORK website and posted to the 

both notice boards.  Scratch sheets, sign out/sign in sheets and Unique Sail Number sheets will 

also be needed.  Again, it’s always good to confirm with the RO to see if what format works best for 

them. 

Scoring, Publishing and Posting 
 

After the first final race results have 

been entered, then select the Score 

series button on the main menu and 

change the Options to “Score groups 

of competitors separately – scoring 

system is applied to each group”.  

Make sure the Grouping field is 
“Fleet”. 

Very important!!!!   Do not score the 
results until you have finish data for 
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all fleets in the first race.   The results will get messed up if you score the results without having 
data in the first final race. 
 
At this point, the requirements for scoring and posting results will be the same as in Chapter 6. 

5.4 Changing a Qualifying Result after a Final Series Result 

Once qualifying races are completed and before a race in the final series is run, no change to a 
qualifying result should be made as this could affect the calculation of splits into fleets for the final 
races.  Race officers, jury and event organizers invest much effort in deciding all the protests and 
inquiries after the qualifying races so that the split into the final races can be made cleanly and 
without the need for subsequent adjustment.    

By selecting “Do not recalculate qualifying race points when at least one finals race has been 
sailed” in the Edit scoring system tab App LE Addendum C, you are ensuring that qualifying 
results – the basis for assigning fleets for the final series – are not affected when scoring the final 
series. (See section 5.3 above for more information.)   

Unwind Fleets – Correct Flights 

Occasionally however, after the fleet splits are made and the first finals race scored, a situation 
may arise that requires a rescoring of the qualifying race results.  Should a Race Officer make such 
a request, it will be necessary to “unwind” the changes made in Sailwave from fleets, return to 
flights and make the scoring change requested.   The process is as follows: 

1) Deselect or uncheck the App LE AddendumC checkbox for the “Do not recalculate 
qualifying race points when at 
least one finals race has been 
sailed”. 

 

2) Go to the Scoring codes 
and reset the penalties to “the 
number of boats in the biggest 
start in the race + N places” rather 
than the “number of boats included 
in the series + N places”. 
 

3) Perform the similar changes 
for the percentage point award 
penalties. Remember to set the 
Value box to the appropriate 
number while making these 
changes.  
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4) Make the requested corrections to the flight or qualifying races and the results scored. 
Check the “Score all competitors as one group – scoring system is applied once” and do not 
check the “Sort results by field after scoring”. 

 

 

Restore Fleets 
 

After the change is made, it is important to restore all series settings back to the fleets and the 
finals races configuration: 

1) Check the scoring option “Do not recalculate qualifying race points when at least one finals 
race has been sailed” in the Edit 
scoring system tab App LE 
Addendum C selection.  
 

2) Go to the Scoring codes tab and 
reset the penalties back to the 
“number of boats included in 
the series” selection, 
remembering to set the 
appropriate values in the Value 
box.  
 

3) The finals race can then be 
scored, scoring the series by 
Fleet. 
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5.5 Checklist for Managing Split Starts 

   

Setup of FLIGHTS Basics 
☐ Add to user interface: “Split starts allowing multiple 1sts, 2nds, etc”., “Appendix LE Addendum C”, 

“Qualification profile” and “Extra competitor fields”  

☐ Under the Edit scoring system/Race scoring tab select “Allow multiple 1sts, 2nds, etc.”  

☐ Under the Edit scoring system/App. LE Addendum C tab select “This series comprises qualifying races and 

final races”  

☐ Under the Edit scoring system/App. LE Addendum C tab set the “first finals race” number  

☐ Under the Edit scoring system/App. LE Addendum C tab select "Do not recalculate qualifying race points 

when at least one finals race has been sailed"  

☐ Under the Edit scoring system/Series scoring tab set the “Discard profile”  

☐ Under the Edit scoring system/Scoring codes tab set the scoring penalties to “Biggest start in any 

race”.  Don’t forget to set the “Value” field. ** Check the Sailing Instructions 

☐ Under the Tools tab set the Flight Assignments and apply to all the Qualifying races (set order based 

on initial seeding) 

☐ Create the flight races/start for the whole qualifying series (naming convention Q1, Q2, Q3, etc.) 

☐ Run “Unique Sailnumber” for each flight and the overall series 

☐ Post the flight assignments online 

☐ Print the flight assignments from the online version  

☐ Post the flight assignment on the Official Notice Board (ONB). 

☐ At the completion of a day of qualifying racing: post results online, print the results from the online 

version and post on the ONB.  

☐ Under the Tools tab set the new Flight Assignments to all the Qualifying races that have not sailed 

yet.  Make sure that the results are sorted by rank 

☐ Repeat the above six steps during the qualifying series 

 

Setup of FLEETS Basics 
☐ Under the Edit scoring system/App. LE Addendum C tab make sure that the “first finals race” 

number is correct. 

☐ Assign the boats to fleets using the set competitor field option.  Assign Gold, Silver, Bronze, etc to 

field Fleet. 

☐ Create the fleet races/starts for the whole final series (naming convention F1, F2, F3, etc.) 
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☐ Run “Unique Sailnumber” for each fleet and the overall series 

☐ Post the fleet assignments online 

☐ Print the fleet assignments from the online version and post on the ONB 

☐ Under the Edit scoring system/Scoring codes tab set the scoring penalties to “Number of boats 

included in the series”.  Don’t forget to set the “Value” field. ** Check the Sailing Instructions 

☐ Enter results and score by “Grouping Field” Fleet 

 

Process to change a qualifying result after final series race results  
☐ Under the Edit scoring system/App. LE Addendum C tab deselect "Do not recalculate qualifying race 

points when at least one finals race has been sailed" 

☐ Under the Edit scoring system/Scoring codes tab set the scoring penalties to “Biggest start in any 

race”.    Don’t forget to set the “Value” field. ** Check the Sailing Instructions 

☐ Change the result(s) 

☐ Score the series using the first scoring option "Score all competitors as one group - scoring system 

applied once" and ensure the box just underneath this option is not selected. 

☐ Under the Edit scoring system/App. LE Addendum C tab select "Do not recalculate qualifying race 

points when at least one finals race has been sailed" 

☐ Under the Edit scoring system/Scoring codes tab set the scoring penalties to ““Number of boats 

included in the series””.  Don’t forget to set the “Value” field. ** Check the Sailing Instructions 

☐ Score series by group and use "Fleet" 
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CHAPTER 6 – Race Committee: Score Races 
 
As indicated the Chapter 2, the timely and accurate collection, processing and communication of 
racing results depends on solid teamwork.   Clear communications with the Race Committee and 
in particular, the Start and Finish Recorders before, during and after races are run minimizes 
errors and scoring inquiries –i.e. key indicators of performance in scoring (see Chapter 9). 
    

6.1 Working with On-Water Recorders 
 

The Start and Finish Recorders are responsible for recording all race information on official record 
sheets6 on water.  Recorders work collaboratively with the Scorers to exemplify the timely and 
efficient collecting, sharing and processing of start and finish data.  Scorers appreciate that this 
task can sometimes be quite challenging due to numerous small, all-white boats moving in and 
around the finish area at the same time and/or weather conditions that impair visibility of sail 
numbers that are up to seven digits long.  
 

Each course Race Officer (RO) is responsible for overseeing the work of the Recorders and Scorers 
assigned to his or her course.  Typically, the RO assigns a primary Recorder to transmit start and 
finish results to the scorer assigned to the course.  For efficiency, only one member of each Finish 
Team should be assigned transmission duty – sending the start data and finish sheets to the Scorer 
as soon as possible after the race is completed.  This may change in racing configurations where 
the Start Recorder is on a different boat than the rest of the Finish Team. 
 

Daily Briefings 
 
Each morning at every CORK event, the Lead Scorer participates in Event Management meetings 
to review the previous day’s racing, clarify expectations for the day’s races and identify any last-
minute changes to courses and/or classes that may affect scoring. 
 
The All-Volunteer Briefing that follows Event Management meetings is an important opportunity 
to collaboratively trouble-shoot any scoring issues that may come up on the race course with 
input from every team member whether on-water or on-shore.  During this briefing, recorders and 
scorers should review the scoring process for the previous day’s races, what went well or didn’t 
work at all, and identify possible improvements that can be implemented immediately.   
 
 
 
 
 

 
6 CYA Race Management Committee, “Join the Race Committee Team! An entry level training manual for race committees”, 

page 24. 
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Official Forms - Race Data 
 

Each scorer should expect to receive at minimum two completed forms of race data for each race: 
Start Line Data sheet and Finish sheet. 
 
Start Boat Data Sheets 
 
One Start Data Sheet for each race should be completed by the Start Recorder and sent to the by 
text or email to results@cork.org immediately following the start of the race.  The Start Data sheet 
includes at a minimum the following key pieces of information: 

▪ Date 
▪ Time of Start for each class 
▪ Race number (in a series) 
▪ All boats starting and finishing the race, including competitors who do not complete or 

finish the course 
▪ Competitors who did not start (DNS), did not 

compete (DNC) or were on the course side 
(OCS) of the race course and did not start 
properly 

 
If there are OCS competitors, the scorer will note 
this penalty and post the Start Data sheet on the 
Official Notice Board.  Start Line data is also relayed 
to the website.   
 
Other information such as wind direction and wind 
strength may be included on Start Data sheets.  All of 
these data enable scorers and on-shore personnel to 
estimate when races will be finished and when 
finish data can be expected.  All of these data may 
become critical pieces of evidence if competitors 
make a scoring inquiry or participate in a protest 
hearing.   

 
Finish Sheets  
 

 

Email to: results@cork.org 

 

SIGNAL BOAT DATA SHEET 
 

Name of Recorder: 

Course: 

 

Race#   

 

Page              of 

 

Class      

Start Time      

# of General Recalls      

Wind Strength      

Wind Direction      

 

Individual Recall Penalties Work Area and Notes 

 Class Sail # Penalty Code 

   OCS UFD BFD 

1      

2      

3      

4      

5      

6      

7      

8      

9      

10      

11      

12      

13      

14      

15      

Penalty Codes 

UFD – DSQ under Uniform Flag 

BFD – DSQ under Black Flag 

(These penalties are applied by race committee and should be recorded 

here and submitted to results 

 

mailto:results@cork.org
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As competitors ROss the finish line on-water, 
recorders write down the sail number of each 
competitor on a Finish Sheet.  As noted earlier, this 
task may be difficult when competitors finish as a 
group and conditions impair visibility of sail numbers 
that are up to seven digits long.  To identify and 
minimize transcription errors, there may be as many 
as three recorders writing down finish data.  Race 
data recorded on the Finish Sheet are: 

▪ Name of Recorder 
▪ Course and Fleet name 
▪ Race number 
▪ Date and Start Time of the race  
▪ The finishing position of each boat  
▪ The time of the first and last finishers of one-

design boats 
▪ Protest flags, “I” flags or other flags seen by 

the Finish Recorders 
▪ Protest information from competitors 
▪ Competitors who retired after finishing 

 
Note that the “Race Number” is always the race number of the entire series.  Scorers should ensure 
that all finish recorders adhere to this numbering system to avoid confusion and minimize data 
entry errors. 
 
The Finish Sheet shown at the right assumes that 
there are 50 or fewer competitors in the race.  CORK 
also has finish sheets with spaces for sail numbers of 
1-100 competitors and 100-200 competitors.   
 
Mark Roundings 
 
Race officers assigned to manage the race turning 
marks will often record the order by which the 
competitors pass by their station on the race course.  
Each mark is numbered in the Sailing Instructions but 
typically, race officers will refer to their mark by 
name – e.g. weather, leeward, or pin.  Race data 
recorded on the Mark Roundings sheet include: 

▪ Mark number or name 
▪ Rounding number (competitors round the 

same mark up to three times during a race) 
▪ Time that the first and last boat rounds 

 

 

1-50 Finishes      Fleet: 

                                        Start time: 
   

Name of Recorder 

 

Course: 

Race #  

Date: 

Page                        

 
 Sail Number  Notes   Sail Number  Notes 
1    26    

2    27    

3    28    

4    29    

5    30    

6    31    

7    32    

8    33    

9    34    

10    35    

11    36    

12    37    

13    38    

14    39    

15    40    

16    41    

17    42    

18    43    

19    44    

20    45    

21    46    

22    47    

23    48    

24    49    

25    50    

Email to: results@cork.org 

MARK ROUNDINGS 
 

 

MARK NUMBER                  ______ 

ROUNDING NUMBER         ______ 

TIME(first boat rounded)       ______   

TIME(last boat rounded)        ______ 

 

Race #  _____    of  _____ 

 

Name of Recorder 

 
 Sail Number  Sail Number  Sail Number  Sail Number 
1  26  51  76  

2  27  52  77  

3  28  53  78  

4  29  54  79  

5  30  55  80  

6  31  56  81  

7  32  57  82  

8  33  58  83  

9  34  59  84  

10  35  60  85  

11  36  61  86  

12  37  62  87  

13  38  63  88  

14  39  64  89  

15  40  65  90  

16  41  66  91  

17  42  67  92  

18  43  68  93  

19  44  69  94  

20  45  70  95  

21  46  71  96  

22  47  72  97  

23  48  73  98  

24  49  74  99  

25  50  75  100  

Email to: results@cork.org 



 

 
CORK RESULTS MANAGEMENT MANUAL VER.10  

© 2019 CORK 

49 

▪ The order that each boat rounds by sail number  
 

Mark Roundings sheets may be particularly useful if there are issues identifying the position of a 
competitor at the finish line, if there is a scoring inquiry or if there is a protest hearing.   
 

6.2 Receiving and Entering Finish Data 
 
After all on-water recorders have validated finish data on their respective finish sheets, a lead 
recorder takes a picture - .jpg - of the most legible or complete Finish sheet and emails or texts it 
to results@cork.org.   The Scorer who receives the jpeg photo will open it and using software such 
as Picture Manager, adjust for rotation, ROppingcropping, clarity, and sharpness.    
 
The Scorer will then print the jpeg and 
examine the results carefully and look for 
potential issues such as duplicate sail 
numbers, transposed numbers, etc.  Check the 
Signal Boat Data Sheet to ensure that all the 
information such as start time for each fleet 
and penalties are also on the Finish sheet.   
 
Data Entry Approach 
 

As described in Chapter 2, one scorer is 
usually assigned to a course and fleet with the 
authority to enter and manage the results for 
that course and fleet.  Some scorers find it 
very helpful to have another person read the 
sail number aloud as they enter sail numbers.   
 
Regardless of the entry approach, it is 
advisable to make a red ink check mark beside 
the sail number as each sail number is entered 
into Sailwave.  When the numbers are read 
back from Sailwave, a ROss cross check on the 
red check mark should be made.  Any issues 
should be circled and noted for consultation 
with the course recorders when they return to shore.  See the example on the finish sheet right. 
 

Using Sail Number Wizard 
 
Sailwave’s Sail Number Wizard – “Sail num wizard” - is the function for entering the order of 
finishes by sail number as shown on the Finish Sheet.  Click the Sail num wizard button on the 
toolbar to begin then follow the steps below: 

mailto:results@cork.org
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1) Select Race Number, 

Field SailNo, hit next. 
Note that you can just 
hit the return key to go 
to the Next page for 
speedy entry. 

 

 

Tip: Use the “match Last 
x chars only” option for 
classes like the Lasers.   
Their results will be recorded on the results sheet by last 4 or 5 digits. 
 
 
 
 

 
2) Enter the sail number in the order on the Finish sheet.  The Sail num wizard will make a 

beep sound when you have entered enough to uniquely match one sail number.  For 
example, if you type 312 
that may be enough to 
uniquely identify the 
boat 3124 in the list of 
competitors. 

 
Tip: Check the “Don’t 
show competitors who 
have already have a 
result for this race” to 
help with faster initial 
entry. 
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3) Once you have entered the 
number, hit the Enter key to 
go the next screen to enter the 
next sail number on the finish 
sheet.  Note for CORK One 
Design regattas, you will 
always be entering the data 
with the “Place or 
Retirement Code” button 
selected.  The values for the finishing position will default to the next position for each 
entry. 
  
Hit enter again to finish entry and start the next result entry. Note that when entering the 
finishing position, it will default to using the next finishing position.  
 
Tip:  For even faster entry once you have uniquely entered the sail number for a finisher, just 
hit the “+” key. This enters the competitor in the next finishing position and restart the Wizard 
for the next entry. This allows 
for extremely rapid entry of 
the result.  Always place a 
check mark on the results 
sheet as each result is entered. 
 

4) After entering all the finish 
positions, check the finish 
sheet to see if there are any 
penalty codes (e.g. DNF, RET, 
DNC, etc.) associated with a 
finisher.   At the right of the 
‘Place or code’ field, select 
the appropriate penalty code 
from the popup menu.   Then 
hit the finish button. 
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5) After entering all results, choose Edit Race by right 
clicking on the header for the race and confirm the 
Name of Race (R1, R2 etc) and set the published 
date or day (Sat/Sun etc is fine) and start time of the race.  These fields appear at the top of 
any published results, so accuracy is important. 
 
 

6) Finally, initiate the scoring of the first race using the ‘Score Series’ button.   
 

Correcting Entry Errors 
 
The next step is to ROsscross-check the results entered in Sailwave against the finish sheet noting 
any anomalies such as a sail number on the finish sheet that does not appear in Sailwave.  Try to 
resolve any inconsistency by identifying if it is a recorder/transposition error on the finish sheet – 
i.e. numbers reversed.    
 
Entry errors should be noted, the correction initialed on the Finish sheet.  If the sail number can’t 
be explained as a straightforward error or is not the competitors’ list, the issue should be noted 
and described to the Race Officer (RO) on shore at the end of the day.  In every case, the RO should 
be briefed on any corrected or outstanding data entry issues and should approve any changes to 
the final results. 
 
Important:  Never edit the 
competitor result directly by 
double clicking their result. You 
will end up with duplicate results. 
(The only and rare exception is a 
photo-finish.) 
 
The correct sail number should be 
entered in Sail num wizard at the 
end of the other finishers.  This 
competitor will then have to be 
moved to its correct finish position 
using the ‘Rearrange recorded 
places’ tool which can be accessed 
either by: 
▪ the blue up-down arrow to the 

right of the ‘Sail num wizard’ 
button, or 

▪  the Tools pull-down menu 
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1) Find the finisher that was immediately ahead of the result that needs to be changed. Check to 
be sure of the competitor name and the correct fleet. 
   

2) Select the incorrectly placed competitor. Move them using the up arrow until they are 
immediately below the finisher you found above. 

 

3) Click OK and then choose Rescore.  
  

4) Double-check the results to ensure that the corrected competitor is now in the correct 
position in their fleet.  

 

6.3 Publishing & Posting Preliminary Results 
 
Once all the finish data has been entered and scoring has been done for each race, it’s important to 
let the competitors, families and spectators know the results!   This is done by posting the printed 
race results on the official results board and by publishing results directly to the CORK website 
and but first … 

 
Enter Sign-Out/Sign-In Penalties  
 
After racing starts and ends each day, the CORK Office gives the Results Room an official form that 
identifies any competitor who has failed to sign out before going out to race or to sign in when 
coming off the water.  The sign-out or sign-in penalty should be applied to the competitor’s first or 
last race that day.   To apply the penalty in Sailwave, select it from the popup menu in ‘Sail num 
wizard’ at the right of the ‘Place or code’ field.   Sign-out/Sign-in penalties are part of the Scoring 
system set-up – see Chapter 3.  See Chapter 4 for more information on Sign Out/Sign In sheets. 
  

Proofread Data Entered 
 
As a general rule, it’s good risk management to 
proofread your work by having the data entry 
person read back the last two digits of the sail 
numbers and circle or ROss cross check each red 
pen mark showing the proof.  
 
Tip:  For proofreading, do a primary sort of the 
file by fleet and a secondary sort on that race 
column. Then reading back the sail numbers is 
faster.  
 
Effects 
 



 

 
CORK RESULTS MANAGEMENT MANUAL VER.10  

© 2019 CORK 

54 

Each year, in response to different sailing organizations and event requirements, CORK’s Event/IT 
Team adjusts and improve layouts and style of published Results.  Two recent changes have 
become standardized for all CORK events – addition of nationality flags and colour highlights of 
the 1st/2nd/3rd positions for each race.     
 
These effects – scripts written in Javascript that increase the functionality of published pages - are 
configured in the ‘Publish web page – destination options’ screen.  Below are two examples of final 
results that show how these standard effects enhance the published results: 
 

 

 

 

 

 

 
Laser Master Canadians 2018 

• From left to right, note that the country flags immediately follow Rank, then Sail number, Skipper, Age 
category, then Province/State flags. 

• In each race, the competitor in first place is highlighted in yellow (gold,) second place in blue (silver) and 
third place in red (bronze).   

 

   
 
International Optimists Gold Fleet 
• From left to right, the country flags immediately follow Rank, then Sail number, then Skipper – similar to the 

Laser Master example. But Age categories aren’t displayed in Opti fleets. 

• Province/State flags in this example are shown at the far right beside Club. 

• In each qualifying series race (Q1, Q2, Q3…), three 1st, 2nd and 3rd places are highlighted.  This is because 
there were three flights in this qualifying series. 

• In the final series races (F1, F2 and F3), the competitor in first place is highlighted in yellow (gold,) second 
place in blue (silver) and third place in red (bronze). 
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• Less than half of Gold Fleet results are shown in this example.  There were 50 competitors in that fleet, 50 in 
Silver Fleet and 45 in Bronze Fleet.  On the website, results for Silver then Bronze Fleets would be presented 
below Gold Fleet.   

 
 

 
Publish Results 
 

If the preview version looks correct in format, layout and content, then it’s time to publish! Always 
rescore before publishing and save the series.  Then follow the steps below. 

 
1) From the toolbar menu, select Publish-

>Results for the ‘Publish web page’ 
options 

 
2) Choose ‘Provisional or Final’ from the 

popup menu to the right of the Title field. 
 

3) Under the What to publish tab, select 
‘Publish a Series Summary Table’ then 
check ‘All sailed races’.   

 
Note: Do not check ‘Individual race tables’ 
nor ‘Publish a prize winners table’ on the 
right of the window.  See Chapter 8 for 
details about setup and publishing the 
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Prize table. 
 
 
 
 
 

 

4) Under the Options tab, check ‘Include race 
dates, Include race times and Separate rows’ 
for dates and times for the ‘Series summary 
table’.  
 
Then hit the ‘Next’ button on the bottom right to get to the Publish web page :: destination 
options window. 

 
 
 
 

 
5) In the ‘Destination’ field, select ‘My default 

internet browser’ then the ‘Preview’ button.  
The results sheet will open in locally.   
 
‘Preview’ allows the scorer to identify results 
that may not seem quite right – such as a boat 
showing as DNC (did not compete) who had 
sailed all the previous races or a DNF for a 
problematic sail number when entering finish data.  Review the results carefully. You have the 
time now to make sure everything is correct before you put it out to the world.  
 
‘Preview’ also allows the scorer to check that the column layout set up under Series 
Properties (Chapter 4) – e.g. logos for CORK and Event sponsors, Event Title, links for the 
racers’ World Sailing number and country flags – are in the right order. 

 

Hint: While previewing, use the View->Columns…  function to minimize unnecessary 
information. Just edit each column to indicate if it should appear in the published output. 

 

6) If you are satisfied that the previewed results are correct, then you’re ready to publish to the 
CORK website.  Close the preview version, go back to the ‘Publish web page’ and choose ‘A 
website using FTP’ from the ‘Destination’ field.   Then select the ‘Publish’ button at the bottom 
right of the screen.  Sailwave will display a few screens that indicate the results are being 
published to the CORK web page and when the publishing is done.   
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7) Go to the CORK website and find the Results page for your fleet.  Print three copies of the 
published results from the web.  Post one copy in the Results Room on the blue board and 
post the second copy on the Official Notice Board.  The copy on the blue board should always 
be the latest version for easy access when investigating scoring inquiries. 
 
The third copy is filed in the scorer’s course binder with the working copies received and used 
for data entry.  Staple the two (or more) data entry sheets together so that all paper for that 
race stays together.  

 
Important: For Media/Marketing purposes, it is very important to publish and post the preliminary 
results after every scoring change.   
 
The timeliness of scoring is a key performance measure: both the time between race finish and 
results to Results Room, and the time from receipt of results  
to publishing & posting the preliminary results.  See Chapter 9 for more information on this. 

 

6.4 Filing during Race Days 
 
Each course scorer is responsible for maintaining his/her paperwork in binders marked with the 
course and fleet name.    
 
Once all the results are in, scored, and the results posted, sort all the paper data by race number 
and staple to the back of the matching race in the “Course Data” file building up from oldest race to 
newest.  Staple together the pages that apply to all races on that course that day, put the page used 
to do the actual data entry as the top page and add the date, time and initials in red ink on the 
page, then file the data sheets.   
 
All race data sheets completed on-water by race officers will be brought to the Results Room at the 
end of racing after boats return to shore.  The Lead Scorer will collect paper race data sheets and 
file them in the appropriate folder which is set-up by course and fleet name.  Often the race officer 
will ask whether there were any data entry issues on their course.  If the scorer is available, the 
race officer will discuss any issues and resolve them as quickly as possible. 
 
But the scorer’s responsibilities aren’t done yet.  Competitors returning to shore will check their 
results on line and some may question whether the result is correct.  Discussion with race officers 
may lead to scoring changes that will be entered by the scorer for that course. 
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CHAPTER 7 – Jury: Enter Scoring Changes 
 

Sailing is a self-regulatory sport where competitors are expected to comply with the International 
Racing Rules of Sailing (RRS).  A scoring change in the posted Results may be required when a rule 
is broken but only after race officials investigate the merits of alleged rule infractions. There are 
several avenues by which competitors can challenge race results that lead to investigation 
including: 
 
• Scoring Inquiry – A competitor may dispute a finish position or score in the Preliminary Results 

posted by filing a scoring inquiry.      
 
• Protest Hearing – A competitor who alleges that another competitor has broken a racing rule 

which impaired her performance and position during a race may file a ‘protest’.  A ‘protest’ is a 
written description of the alleged infraction which is reviewed and assessed by a jury in a 
formal hearing. 

 
• Redress Hearing – A competitor who believes that actions by race committee or umpire 

unfairly affected their race score may request a redress hearing to investigate the issue.    
 

The Lead Scorer is responsible for managing disposition of all scoring changes after racing is 
completed and maintaining records of action taken in a ‘Scoring Changes’ binder. 

7.1 Results Teamwork: After Racing   
 
Scoring changes, protest hearings and jury decisions are made after racing is completed, and the 
Results Room gets very busy.   Each Finish Team brings in all the paperwork from the day.  Each 
Finish Team contact will check with the Course Scorer to ensure that the race results were 
received and entered before filing the paperwork.   
 
This is a crucial time where the Finish Teams and Results Team can demonstrate their teamwork!  
The Scorer will benefit from accurate filing of race data as described in Chapter 6 which can then 
be matched with the Finish Team paperwork.  All pertinent sheets are together with the official 
data entry sheet on top and labelled.  This paperwork may be particularly important when a Jury 
is preparing for or hearing a protest.  Members of the Results Team and Finish Team should be 
prepared to review, discuss and confirm scoring inquiries, race data and related issues with the 
Jury before a scoring change is made.    
 

7.2 Scoring Inquiries 
 

Scoring inquiries are formal documents that need to be investigated carefully before making a 
scoring change.  The information in a Request for Review of a Competitor’s Score (form at right) 
may help correct a transposition error noted by the Scorer.  It may also indicate a possible on-
water infraction that could lead to a hearing.  The number and type of scoring inquiry are key 
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performance indicators of how well the scoring teams performed both on-water and on-shore (see 
Chapter 9 for more information).  
 

Request for Review  
 
Competitors who want to challenge the posted 
preliminary result may obtain and complete a scoring 
inquiry form at the Jury Desk.  Inquiry forms may be 
used for requesting changes to finishing position 
shown on result sheets with evidence, e.g. names/sail 
numbers of witnesses, if scored DNF, DNS, DNC or 
incorrect positions.  Inquiry forms should not be used 
for challenged OCS’s, UFD’s or BFD’s as this is a 
request for redress. (RRS 62).  
 
The Jury Secretary checks the form for legibility, 
ensures that all pertinent information is recorded 
including the date and time the inquiry was received, 
then brings the form to the Results Room. 
 

Results Room Procedures 
 

The first step in investigating any scoring inquiry is to 
log and file it in a Scoring Changes binder.  The Lead 
Scorer receives and reviews the information on the 
scoring inquiry and enters key pieces of information in the ‘Scoring Inquiry Log’.  The Inquiry Log 
sheet is kept at the front of the Scoring Changes binder.  Each inquiry is given a number and that 
number is entered on the form and on the 
Log.  
 
At times, the inquiry can be addressed easily 
by reviewing the change requested against 
the finish time data received from the 
recorders.  It is possible that there was a 
transcription error at the time finish data is 
entered.  The scorer will make the change in 
the Sailwave file, note the details, date & 
time, initial and file the form in the Scoring 
Changes binder according to its log number. 
 
If, however, the Finish Sheets agree with the Sailwave results posted, nothing can be done by the 
Results Team until the RO and Finish Team comes off the water.   
 

 

 

 

 

Received by: 

Date: 

Time:                 No: 

REQUEST FOR REVIEW COMPETITOR'S SCORE 
 

Sailor name  Sail Number  
    

Cell phone  Country code  
    

Class and 
fleet colour 

 Race no  

 

 I have been scored  But this may be incorrect. 
 

 I finished correctly but my finishing position is not shown. 
 

I believe that I finished in   
 

I request that the race committee check their records for a possible error. 

 

Witnesses (name, country code and sail-number) Country code 

  

 

Other information 

 

 

Signed  Date  

 
Data entry checked by Results.  
 

 Race Officer decision. (if boat position changes, indicate before sail no… and after sail 

no….) 
 

     

     
 Signed  Date   
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Race Committee Procedures 
 
As noted in Chapter 6, race officials collect significantly more data about the conduct of racing on-
water both in paper and digital format.  Members of the finish team for example, will usually 
record the calling out of sail numbers as competitors finish on a digital recorder for play back if 
there are discrepancies in the numbers recorded on finish sheets by on-water recorders.  
 

When race officers bring paperwork to the Results Room at the end of racing, the primary 
recorder or RO will ask whether there were any data entry issues or scoring inquiries on their 
course.  If the scorer is available, the race officer will discuss any issues and resolve them as 
quickly as possible.  This may require a review of all records by the Finish Team. 
 

Once an Inquiry has been resolved, the RO shall review details noted on the Inquiry form, enter 
the date & time resolved and initial the form.  On the Inquiry Log form record the date and time 
and fact of resolution and initial it.   
 
If there are any blanks in the Log, the Lead Scorer will ensure that the RO is informed of an 
outstanding issue as soon as possible.  This may involve checking with the Jury Secretary to see 
whether a competitor who filed a scoring inquiry is also involved in a protest hearing.   

7.3 Protests Hearings & Jury Decisions 
 
Results Team members are responsible for entering any scoring changes required after all 
protests have been heard, then re-scoring and re-publishing the day’s re-scored results before 
leaving for the day.  
 
Protest Hearings 
 
As protest forms are logged at the Jury desk, the Jury Secretary and Chief Judge arrange for a 
protest committee to hear the protest.  The Protest Schedule – a board behind the Jury desk - lists 
the competitors who have lodged protests that will be heard before the end of the day.   The Lead 
Scorer reviews the Protest Schedule to identify the class and competitors who may be involved in 
a protest hearing and let the relevant scorer know if a scoring change may be required. 
 
Jury Decisions 
 
A jury decision is a formal ‘scoring change’ document that specifies the scoring penalty resulting 
from a protest hearing.  Not all protest hearings result in a scoring change. 
 

Jury Decisions will be delivered to the Lead Scorer on a document signed by the chair of the Jury 
who heard the protest.  The Lead Scorer will note the date and time the jury decision form was 
received in a ‘Jury Decision Log’ which is part of the ‘Scoring Change’ binder.   
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At times, several decisions affecting several different fleets and courses come in on one form. As 
these decisions are implemented, note the action taken, date & time & initials and file the 
completed form in the ‘Scoring Changes’ binder. 

7.4 Prepare for Next Racing Day 

 
Change of Information Log  
 
During a day of racing, competitors may face equipment and crew changes for a variety of reasons.  
Once the event has begun, the ONLY way changes can be made to each sailor’s data in Sailwave is 
in the Results Room.  All information changes must be filed first with the CORK office.  If a sailor 
(or representative) comes to the Results Room to requests an information change, the Lead Scorer 
will send them to the CORK Office to initiate the process. 
 
The CORK office will itemize the details of a change to Registration data first, then send the 
‘Change of Information’ form to Results on a form signed by a CORK event chair or co-chair.  The 
Lead Scorer will then ask the appropriate scorer to make the change in Sailwave.  Once that 
change to competitor information has been made in Sailwave, the scorer will note the date, time 
and his or her initial on the ‘Change of Information’ form and file it in the ‘Scoring Changes’ binder. 

 
Results Room Daily Log 
 
The Lead Scorer is required to note important aspects of the activities of the day and how they 
were dealt with.  For example, if the Race Officer requests atypical information or a change in 
format of the printed or posted results, the Lead Scorer will note the information and how it was 
addressed.  Both teams are continuously looking for ways to improve procedures and most 
importantly, the CORK experience for competitors and volunteers alike.  
 
At the end of the day, if a change in process or an action has not yet been implemented, this should 
be noted on the Daily Log.  Since different volunteers may be on scoring and race committee duty 
at different times, the daily log ensures that whoever opens each morning will know what items 
are outstanding at the end of the previous day.  This helps the entire Results Team keep abreast of 
what needs to be done to ensure the success of the event.  

 
Action items that may be outstanding each morning include: 
Update in the staffing schedule for the Results Team. 
Review Scoring Changes binder for forms that may have come into the Results Room late the 
previous day or early in the morning.  Address them early in case they lead to changes of 
information for the current day’s races. 
Ensure new Scratch Sheets with updated information are printed and available for race officials.   
Check with Registration to see if there’s been any change in competitor information before doing 
this. 
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Clean and tidy up the Results Room. Check that all the forms from the day’s racing are filed 
correctly. 
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CHAPTER 8 – Finalize Results 
 
Shore-side gets very busy on the last day of the event when the Media/Marketing Team showcases 
the winning competitors.   This wouldn’t be worth all the effort without prizes would it!? 

8.1 Awards Ceremony 
 
The Results Team must make a special effort to finalize Results on all courses before boats return 
to the docks, well before the Awards Ceremony. 
 

Each Course RO will work closely with the Results Team to expedite scoring inquiries. Until 
outstanding issues are resolved, the results cannot be finalized.  Course ROs give out awards to the 
prize winners and need to be comfortable that the end product makes sense.  Correctly calculated 
results and prizes are key products of an amazing amount of teamwork! 
 
To stay on schedule, the Media/Marketing Team sets the time for the awards ceremony after 
getting feedback from the Lead Scorer, Event Chair, PRO and course RO.  Often, an outstanding 
scoring issue affects the top-placed competitors and the prizes to be awarded.   

8.2 Set-up the Prize Table  
 
The prize table is list of event winners calculated from the results in Sailwave.  Prize tables may be 
set up any day based on information and the Sailing Instructions (Sis) but they are not published 
and posted until the Awards Ceremony.   At a minimum, each scorer is expected to set up a prize 
table based on the course results on the last day before the boats come off the water.   
 
The steps for setting-up the prize table are as follows: 
 
1) From the toolbar, select Setup->Prizes.   

2) Hit the ‘New’ button, then the ‘Edit’ button. 

3) In the ‘Edit Prize’ window, describe the prize in the 
Category field. Repeat this step to describe as many 
prizes as required.  Check with the RO and 
Media/Marketing team about wording for the SI-
defined prizes or any special prizes. 

Typically, there’s only one 1st, 2nd and 3rd place winner 
for each class or fleet of boats.  However, Sailwave 
offers the flexibility for more than one prize to be 
awarded in any one category. 

 

4) After all the prize categories are described, hit the 
‘Select competitors’ button.  
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5) Eligible competitors are then 
determined in the value/fields of the 
‘Select competitors’ window.  Each 
Prize consists of selection of 
competitors e.g. Top Female Optimist 
would use Fleet and Rank.  

Sailwave recognizes that there may 
be some trial & error to get these 
formulas correct, especially when 
there are different age groups to 
consider.  Use the ‘Test’ button to 
check whether you’ve entered the 
correct values. 

 

 

6) If all prize categories pass testing, save 
the file then go to the Publish->Results 
menu.  Preview the prize table after 
checking off the ‘Publish a prize 
winners table’ at the right of this 
window.     
 

 
 
 
 
 
 
 
 
In ‘Preview’, the prize table should appear 
at the bottom of the Provisional Results and 
look something like the example at right 
from the 2018 International Optimists.  
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8.3 Confirm & Publish Final Results  
  
Final Review & RO Sign-off 
 
Before the Awards Ceremony, the course scorer should print a copy of the Provisional Results 
with Prize table for final review and sign-off by the RO.  This review could include a discussion of 
how scoring changes were managed but at a minimum, it may provide commentary that the RO 
could use to help make the Awards Ceremony interesting and memorable.    
 
If time is tight and the Award Ceremony is about to start, the final review by the RO and 
confirmation of results may take place even though not all scoring changes have been entered.  
The PRO and Chief Judge may determine that a pending scoring change will not affect competitors 
in or near the prize winners table.   
 
However, the results shall never be signed-off by the RO until all scoring changes have been 
entered.  As mentioned often in this manual, the RO is ultimately responsible for the conduct and 
results of racing on his/her course. 
 
Publish Final Results 
 
Once the RO has signed-off the Provisional Results certifying that no further changes are 
anticipated and the Awards Ceremony has begun, the Scorer has effectively been given authority 
to finalize the Results.  This is done simply by selecting the ‘Final’ button in the Publish web page 
:: results options  menu.  Note that the ‘Publish a prize winners table’ box has been checked in the 
window below. 
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8.4 Winding-up 
 

Depending on the event, the Results Room may need to be disassembled or simply cleaned up in 
preparation for the next event.  In either case, filing official records is the first step.   
 
Records Management 
 
Official records of results need to be retained in the CORK office in case of appeals or related 
questions from competitors.  At the end of the event, clear all the Blue Boards and collect all the 
forms in the Course file folders (both the data forms and the printouts) as well as Competitor Lists, 
the Sign Out/Sign In penalty file, the Change of Information Forms, and Inquiries.  Folders are then 
put in large brown envelopes or bags which are labelled by event, course, and fleet.   
 
Closing the Results Room 
 
After filing is completed, the Results Team can either start to set up the next CORK event or tear 
down the room on completion of all events.   
 
Tear-down involves shutting off all computers and advising the IT support group about any 
specific issues within hardware or software observed during the event.  Room dividers are stacked 
and office equipment such as boards, binders, file folders, pens and markers are bundled and 
placed in storage bins.   
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CHAPTER 9 - Continuous Improvement 
 

9.1 Critical Success Factors 
 
As noted in Chapter 1 Introduction, the timely collection, processing and communication of racing 
results to competitors, coaches, jury and other regatta stakeholders are critical success factors.  
Critical success factors are things that must go right to achieve an organization’s vision and 
mission.  
 

Information on each day’s scoring - e.g. times 
of receipt and publishing results - will be 
collected by the Lead Scorer at the end of 
each race day.  At the end of the event, this 
data will be tabulated and may form part of a 
report to the Event Management team.   
 
As noted in Chapter 6, measuring 
performance in the sport of sailing is a particularly difficult.  Even when the technical skills of the 
competitor and race management are peerless, weather conditions or equipment failures can 
impair performance on the water and impact results.  Similarly, the performance of the Results 
Team and the Scoring System must be measured using attributes directly related to scoring. 
 
 

9.2 Event Key Performance Indicators 
 

At the end of each race day, the Lead Scorer is expected to collect data designed to measure two 
attributes of scoring – timeliness and effectiveness. 
 

 
Timeliness – Time from receipt of finish sheets to publishing & posting 

 

 
As noted in Chapter 6, completion of finish sheets by on-water recorders may be delayed by 
several factors beyond the control of the scorer.  But once the finish sheet has been received in the 
Results Room, the Results Team is expected to enter the data quickly and correctly, proofread and 
preview the results, publish on the CORK website, then print and post provisional results after 
each race.  
 
The length of time will vary depending on the number of boats per fleet – i.e. more boats to enter, 
more time needed.  However, for every event, as scorers become more familiar with the fleet and 
experienced, the average time between data entry and publishing should decrease.  
 

The key to success is MEASUREMENT. 
Measurement done right can transform your 
organization … measurement is fundamental to 
high performance, improvement, and, ultimately, 
success … in any area of human endeavor. 

Dean R. Spitzer 
Transforming Performance Measurement 

 

https://www.amazon.com/dp/0814408915
https://www.amazon.com/dp/0814408915
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Effectiveness – 

 

 

 
Not all Scoring inquiries are equal.  After reviewing the details in the scoring inquiry form, the 
Lead Scorer will ascertain whether the scoring inquiry is related to a request for redress or 
pending protest.  While this information is important for RO’s to see, they should not be included 
in the calculating the effectiveness of the Results Team. 
 
Although teamwork is paramount, the Results Team’s performance should be measured by 
scoring inquiries directly related to errors by the on-water recorders on the finish sheets and the 
course scorer.  As noted in Chapter 6, these errors are often easily averted by proofreading, or 
corrected after consultation with the race committee and additional race data at the end of the 
race.     
 

9.3 Scoring System Performance 
 

At the end of the season, CORK’s Chief Scorer will review the performance summaries for each 
event and transfer the data to a performance measurement framework (PMF).  The PMF will be 
used to track the above attributes over time, evaluate the performance of CORK’s Scoring System 
and identify possible improvements that should be made each year.  A performance dashboard 
will be developed to summarize the performance metrics.   
 
A request for competitors/participants’ feedback on the performance of the Results Team and 
Scoring function will be included in CORK’s annual evaluation process.  In addition, a debrief 
questionnaire and the performance dashboard will be sent to each member of the Results Team at 
year-end to help identify where improvements can be made to the Scoring System in the following 
year.  Over time, a scorecard for scoring is anticipated which will help the Results Team predict 
areas that will need special attention as the portfolio of CORK events grows.  

  

Number of Scoring Inquiries  
________________________________________________________________________________ 

Number of Boats 
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APPENDIX A - Glossary 
 
CRMS – CORK Race Management System 
DNC – Did Not Compete.  The score given to a boat that is entered in a race but does not show up 
to the starting area 
DNE – Disqualification Not Excludable.   
DNF – Did Not Finish.  The score given to a boat that starts the race but does not finish. 
DSQ – Disqualified.  The score of a boat that, after a protest hearing, is given a penalty of 
disqualification by the Protest Committee. 
Finish – A boat finishes when any part of her hull, crew or equipment in normal position ROsses 
crosses the finish line from the course side. 
FTP – File Transfer Protocol (FTP) is a set of rules used to transfer computer files between a client 
and server on a computer network.  
Jury – A panel of judges appointed to hear protests or redress hearings 
Jury Secretary – Individual who receives and logs scoring inquiries and administers paperwork 
relating to protest hearings. 
Line Sighter – A member of the race committee appointed to identify boats OCS at the start  and to 
identify sail number of boat finishing and any protest flags at the finish. 
Low-point scoring system – The most commonly used scoring system (Appendix A of the RRS) 
OCS – On Course Side.  A score given to a boat that has ROssed crossed the starting line before the 
starting signal and does not return to start properly.  
NoR – Notice of Race 
Protest – An allegation that another boat has broken a rule. 
Protest Committee – A jury or group of people appointed to hear protests 
Protest Flag – A red flag displayed by a competitor to signal his intention n to protest. 
RO – Race Officer.  The leader of the race committee on a specific course. 
PRO – Principal Race Officer.  The leader of race management when there are several courses at 
one event.  Each course has its own race management team. 
Race Committee – A team of people who run the race on a specific course. 
RET – Retired.  The score given to a boat that retires. 
RDG – Redress Given.  The score of the boat that, after a protest hearing, is given redress under 
RRS 62. 
RRS – Racing Rules of Sailing. 
Scorer – The person who calculates the score of each boat after the race. 
Scoring Penalty – An alternative penalty to disqualification. 
SI’s – Sailing Instructions 
STMP – Simple Mail Transfer Protocol (STMP) is a set of rules used for sending and receiving 
emails.   
World Sailing – The international sailing association responsible for overseeing world class 
competition including registering competitors (formerly ISAF). 
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APPENDIX B – RRS Part 7 Race Organization & Appendix A: Scoring  
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 PART 7 

 RACE ORGANIZATION 
 

84 GOVERNING RULES 

The organizing authority, race committee, technical committee, 

protest committee and other race officials shall be governed by the 

rules in the conduct and judging of races.  

 

85 CHANGES TO RULES  

85.1 A change to a rule shall refer specifically to the rule and state the 

change. A change to a rule includes an addition to it or deletion of all 

or part of it.  

85.2 A change to one of the following types of rules may be made only as 

shown below.  

Type of rule Change only if permitted by 

Racing rule Rule 86 

Rule in a World Sailing code A rule in the code 

National authority prescription Rule 88.2 

Class rule Rule 87 

Rule in the notice of race Rule 89.2(b) 

Rule in the sailing instructions Rule 90.2(c) 

Rule in any other document 

governing the event 
A rule in the document itself 

 

86 CHANGES TO THE RACING RULES 

86.1 A racing rule shall not be changed unless permitted in the rule itself 

or as follows: 

(a) Prescriptions of a national authority may change a racing rule, 

but not the Definitions; the Basic Principles; a rule in the 

Introduction; Part 1, 2 or 7; rule 42, 43, 63.4, 69, 70, 71, 75, 

76.3, 79 or 80; a rule of an appendix that changes one of these 

rules; Appendix H or N; World Sailing Regulation 19, 20, 21, 

22, 35 or 37.  
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(b) The notice of race or sailing instructions may change a racing 

rule, but not rule 76.1 or 76.2, Appendix R, or a rule listed in 

rule 86.1(a).  

(c) Class rules may change only racing rules 42, 49, 50, 51, 52, 53 

and 54.  

86.2 In exception to rule 86.1, World Sailing may in limited 

circumstances (see World Sailing Regulation 28.1.3) authorize 

changes to the racing rules for a specific international event. The 

authorization shall be stated in a letter of approval to the event 

organizing authority and in the notice of race and sailing instructions, 

and the letter shall be posted on the event’s official notice board. 

86.3 If a national authority so prescribes, the restrictions in rule 86.1 do 

not apply if rules are changed to develop or test proposed rules. The 

national authority may prescribe that its approval is required for such 

changes.  

 

87 CHANGES TO CLASS RULES 

The notice of race or sailing instructions may change a class rule 

only when the class rules permit the change, or when written 

permission of the class association for the change is displayed on the 

official notice board.  

 

88 NATIONAL PRESCRIPTIONS 

88.1 Prescriptions that Apply  

The prescriptions that apply to an event are the prescriptions of the 

national authority with which the organizing authority is associated 

under rule 89.1. However, if boats will pass through the waters of 

more than one national authority while racing, the notice of race or 

sailing instructions shall identify the prescriptions that will apply and 

when they will apply.  

88.2 Changes to Prescriptions  

The notice of race or sailing instructions may change a prescription. 

However, a national authority may restrict changes to its 

prescriptions with a prescription to this rule, provided World Sailing 

approves its application to do so. The restricted prescriptions shall 

not be changed.  
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89 ORGANIZING AUTHORITY; NOTICE OF RACE; 

APPOINTMENT OF RACE OFFICIALS 

89.1 Organizing Authority 

Races shall be organized by an organizing authority, which shall be 

(a) World Sailing; 

(b) a member national authority of World Sailing; 

(c) an affiliated club; 

(d) an affiliated organization other than a club and, if so prescribed 

by the national authority, with the approval of the national 

authority or in conjunction with an affiliated club; 

(e) an unaffiliated class association, either with the approval of the 

national authority or in conjunction with an affiliated club; 

(f) two or more of the above organizations; 

(g) an unaffiliated body in conjunction with an affiliated club 

where the body is owned and controlled by the club. The 

national authority of the club may prescribe that its approval is 

required for such an event; or 

(h) if approved by World Sailing and the national authority of the 

club, an unaffiliated body in conjunction with an affiliated club 

where the body is not owned and controlled by the club. 

In rule 89.1, an organization is affiliated if it is affiliated to the 

national authority of the venue; otherwise the organization is 

unaffiliated. However, if boats will pass through the waters of more 

than one national authority while racing, an organization is affiliated 

if it is affiliated to the national authority of one of the ports of call. 

89.2 Notice of Race; Appointment of Race Officials 

(a) The organizing authority shall publish a notice of race that 

conforms to rule J1.  

(b)  The notice of race may be changed provided adequate notice is 

given. 
 

(c) The organizing authority shall appoint a race committee and, 

when appropriate, appoint a protest committee, a technical 

committee and umpires. However, the race committee, an 

international jury, a technical committee and umpires may be 

appointed by World Sailing as provided in its regulations.  
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90 RACE COMMITTEE; SAILING INSTRUCTIONS; SCORING 

90.1 Race Committee 

The race committee shall conduct races as directed by the organizing 

authority and as required by the rules. 

90.2 Sailing Instructions 

(a) The race committee shall publish written sailing instructions 

that conform to rule J2. 

(b) When appropriate, for an event where entries from other 

countries are expected, the sailing instructions shall include, in 

English, the applicable national prescriptions. 

(c) The sailing instructions may be changed provided the change is 

in writing and posted on the official notice board before the 

time stated in the sailing instructions or, on the water, 

communicated to each boat before her warning signal. Oral 

changes may be given only on the water, and only if the 

procedure is stated in the sailing instructions.  

90.3 Scoring 

(a) The race committee shall score a race or series as provided in 

Appendix A using the Low Point System, unless the notice of 

race or sailing instructions specify some other system. A race 

shall be scored if it is not abandoned and if one boat sails the 

course in compliance with rule 28 and finishes within the time 

limit, if any, even if she retires after finishing or is disqualified. 

(b) When a scoring system provides for excluding one or more 

race scores, any score that is a Disqualification Not Excludable 

(DNE) shall be included in a boat’s series score.  

(c) When the race committee determines from its own records or 

observations that it has scored a boat incorrectly, it shall 

correct the error and make the corrected scores available to 

competitors.  
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91 PROTEST COMMITTEE 

A protest committee shall be 

(a) a committee appointed by the organizing authority or race 

committee; 

(b) an international jury appointed by the organizing authority or 

as prescribed in the World Sailing Regulations. It shall be 

composed as required by rule N1 and have the authority and 

responsibilities stated in rule N2. A national authority may 

prescribe that its approval is required for the appointment of 

international juries for races within its jurisdiction, except 

World Sailing events or when international juries are appointed 

by World Sailing under rule 89.2(c); or 
 

(c) a committee appointed by the national authority under rule 

71.2.  

 

92 TECHNICAL COMMITTEE 

92.1 A technical committee shall be a committee of at least one member 

and be appointed by the organizing authority or the race committee 

or as prescribed in the World Sailing Regulations. 

92.2 The technical committee shall conduct equipment inspection and 

event measurement as directed by the organizing authority and as 

required by the rules.  
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APPENDIX A 

SCORING 
 

See rule 90.3. 

 

A1 NUMBER OF RACES 

The number of races scheduled and the number required to be 

completed to constitute a series shall be stated in the notice of race or 

sailing instructions.  

 

A2 SERIES SCORES 

A2.1 Each boat’s series score shall, subject to rule 90.3(b), be the total of 

her race scores excluding her worst score. (The notice of race or 

sailing instructions may make a different arrangement by providing, 

for example, that no score will be excluded, that two or more scores 

will be excluded, or that a specified number of scores will be 

excluded if a specified number of races are completed. A race is 

completed if scored; see rule 90.3(a).) If a boat has two or more 

equal worst scores, the score(s) for the race(s) sailed earliest in the 

series shall be excluded. The boat with the lowest series score wins 

and others shall be ranked accordingly.  

A2.2 If a boat has entered any race in a series, she shall be scored for the 

whole series.  

 

A3 STARTING TIMES AND FINISHING PLACES  

The time of a boat’s starting signal shall be her starting time, and the 

order in which boats finish a race shall determine their finishing 

places. However, when a handicap or rating system is used a boat’s 

corrected time shall determine her finishing place. 

 

A4 LOW POINT SYSTEM 

The Low Point System will apply unless the notice of race or sailing 

instructions specify another system; see rule 90.3(a).  
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A4.1 Each boat starting and finishing and not thereafter retiring, being 

penalized or given redress shall be scored points as follows: 

Finishing place Points 

First 1 

Second 2 

Third 3 

Fourth 4 

Fifth 5 

Sixth 6 

Seventh 7 

Each place thereafter Add 1 point 

A4.2 A boat that did not start, did not finish, retired or was disqualified 

shall be scored points for the finishing place one more than the 

number of boats entered in the series. A boat that is penalized under 

rule 30.2 or that takes a penalty under rule 44.3(a) shall be scored 

points as provided in rule 44.3(c). 

 

A5 SCORES DETERMINED BY THE RACE COMMITTEE 

A boat that did not start or finish or comply with rule 30.2, 30.3, 30.4 

or 78.2, or that retires or takes a penalty under rule 44.3(a), shall be 

scored accordingly by the race committee without a hearing. Only 

the protest committee may take other scoring actions that worsen a 

boat’s score.  

 

A6 CHANGES IN PLACES AND SCORES OF OTHER BOATS 

A6.1 If a boat is disqualified from a race or retires after finishing, each 

boat with a worse finishing place shall be moved up one place. 

A6.2 If the protest committee decides to give redress by adjusting a boat’s 

score, the scores of other boats shall not be changed unless the 

protest committee decides otherwise. 

 


